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USING THIS GUIDE AND DDDL ON-LINE HELP

The materia in the printed guide was designed as a convenient basic reference for the main features of the DDDL
software. It isbased primarily on the contents of the on-line Help contained in every copy of DDDL software. The
material in the printed guide is arranged according to the drop-down menu structure of the program, starting with the
“Calibration” drop-down menu and proceeding through the “Tools” selection. While most of the DDDL features are
included, the comprehensive Help section contains a great deal of information not covered in the basic printed guide.

Note: The screensyou will see when you follow this guide on your PC may vary depending on the version
of DDDL you have.

For those users not familiar with using Windows based Help files please take some time to review the materia in this

section. Y ou may access the on-line help section by going to the “Help” drop-down menu in the Diagnostic Link program
and selecting “Help Topics’. Theinitia screen that comes up will be:

Help Topics: EE

Conterts | index | Find |

[I.II Detroit Diesel Diagnostic Link
"= Introduction

Click a book, and then chick Open. Or click another tab, such as Index. @ DODDOL Windows and the Toalbar
@ Menus Step 2

= Y Detroit Diesel Diagnostic
@ DDEC Reports
@ Detroit Diesel Communications

W Detroit Diesel Diagnostic Link
@ Intraduction
)] DDDL Windaws and the Toalbar
2] The Welcome Screen
[?] The Calibration window
[ The Instrumentation windaow
Step 3 [?] The Fault Codes windaw
] The Toolbar
@ Menus

Step 1

Open I Prrint... | Cancel |

Understanding how the three tabs (Contents, Index, and Find) at the top of Help window work will greatly enhance your
ability to quickly find information on the specific topics.
1. Using Contents:

a. Thebook iconsin the “Contents’ tab can be opened to reveal their contents by aleft mouse double click on the book
you wish to open. Y ou may close an open book with aleft double click aswell.

b. Noticethat in Step 2 above, opening the book, “ Detroit Diesel Diagnostic Link,” opens up to three more books of
information.

c. If weopen up book two “DDDL Windows and the Toolbar” you'll find that it contains five topics (listed in Step 3).
The question mark indicates that these listings can be opened for information on that particular topic but it contains no
more sub-topics.

2. UsingtheIndex



Choosing the “Index” tab will reveal the following screen:

Help Topics:

Contents  Indes |Find I

1 Twpe the first few letters of the word you're looking for.

2 Click the index entry vou want, and then click Display.

csf il
CEv

.dhe

dhr

=10

o

.

xtr

About

Ahbout Cooving Data Extraction Files From Other Comnoute
About Detroit Diesel Diagnostic Link

About Navinational Tools

About Svstern Ootiong

About Yehicle Parameters

Accel Switch

Accessing the Extraction Loa

Activate outnut dialog box LI

Dizplay I Eirt.. | Cancel |

The “Index” isan aphabetical listing of the topic titlesin DDDL Help. The*Index” isnot the most useful way to search
for help on a particular word. If theword you are looking for is not the first word in the topic title, your search will come
back without finding anything. For example, if you are looking for information on setting the ECM clock and type in the
word “clock * you will get an unsuccessful search. If you typed in “set” you would be successful because the topic istitled
“Set ECM Clock”. If you want to find help on atopic with a key word you ar e better off using the“Find” tab.

3. Using Find:

Thefirst time you access the “Find” selection, you'll get adialog box asking you to set up the information database:
Y ou may choose the level of search capability you wish to have. Another screen will appear while the setup processis

Find Setup Wizard E3

Find enables you to zearch for specific wards and
phrases in help topics, instead of searching for
information by cateqary.

Before you can use Find, Windows must first create a list

[or databaze], which containg every ward from your help
file(z).

To create this list now click MNest.

" Minimize database size [recommended}

" Magimize search capabiliies

" Customize search capabilities

< Each I Ment » I Cancel |

completed. (This process only happens the first time that you use “Find.”) The next screen to appear will be the normal
“Find” screen. Thisisthe most powerful of the threetabswhen it comesto locating assistancein Help.




Help Topics: BHE

Euntentsl Index  Find I

1 Tupe the word(z) pou want to find
I j Clear

2 Select some matching words to narrow your search

W About C:

[ About Comrmun

[J About Copying Data Extraction Files From Cther Computers

[ About Detroit Diesel Diagnostic Link

[J About Extraction Log Viewer

[J Ahout Mavigational Tools hd|

|2E|4 Topics Found | I All wordz, Begin, Auto, Pauze |

Diizplay I it | Cancel |

Touse"Find" effectively, follow the steps below:

a.  Simply typein the key word you want information about into section 1. Asyou type, the search mechanism beginsto
locate all the DDDL Help topics containing this word. All the topics containing the key word are listed in section 3.

b. Youmay select words to refine the search by clicking on matching words in section 2. This may narrow your search
and eliminate some of the topicslisted in section 3.

c. Scroll down through the list of topics in section 3 using the arrows on the right side of the box until you find the topic
most likely to contain information on the subject. Highlight the topic you wish to examine with asingle left click of
your mouse then, choose the "Display" button.

4. Additional Noteson Help for DDDL 5.0 and L ater

DDDL 5.0 wasthe first version to support both the DDEC and MBE electronics systems. The documentation now reflects
the support multiple systems.

Diagnoztic Instrumentation

Marrnal Ingtrurmentation . .
While many features work with both the

Engine Configuration D ata
. DDEC and MBE system, those features
ECH 1/0 Canfiguration [DDEC I and DDEC 1Y anly] that work with only one system will be

Injector Responze Times [DDEC only) identified in the section heading.
M aintenance Alert [DDEC only]

Activate Outputs [MBE only)
Sermvice Routines [MBE only]

If afeature is common to both systems the differences are also explained in Help.

The infarmation given depends on whether you are using a DDEC or MBE engine - see:

) () 8] [ ) [ o) [-9)

Engine Configuration Data window for DDEC

Engine Configuration Data window for MBE




DROP-DOWN MENU SELECTIONS FOR DDDL 6.3 (DDEC FUNCTIONS)

File Calibration Snapshot

Open Passwords New

Save Retrieve Open

Save As Injector Close

Save Fleet Ca Rating e
Close - User Event
----------- Audit Trails Pause

Print ECM Set Clock Snapshot to CSV
Print Preview

Print Setup

Exit
Diagnostics Tools Window
Fault Codes Engine/Trip Data Cascade
Cylinder Cutout e Tile

DDEC Reports Arrange Icons
Diagnostic Instrumentation ~ -------m--m-me-moooo-
Normal Instrumentation Clear AFR Learn Table

Particulate Filter De-green Reset
Engine Configuration Data Recalibrate NG Oxygen Sensor

Recalibrate EGR DP Sensor
MBE Progressive Shift Calculator
ECM 1/O Options
Injector Response Time

Maintenance Alert
View Observed Mids
Exhaust Backpressure Fault Times

Help
Help Topics

DDEC I, 1, 1V Troubleshooting
DDEC V Troubleshooting
DDC Mechanical Troubleshooting

MBE Electronic Troubleshooting

About Detroit Diesel Diagnostic Link



DROP-DOWN MENU SELECTIONS FOR DDDL 6.3 (MBE FUNCTIONS)
Available MBE functions are in bold type

File Calibration Snapshot

Open Passwords New

Save Retrieve Open

Save As I njector Close

Close  —eeeee- User Event
----------- Audit Trails Pause

Print ECM Set Clock Snapshot to CSV
Print Preview

Print Setup

Exit
Diagnostics Tools Window
Fault Codes Engine/Trip Data Cascade
Cylinder Cutout e Tile
DDEC Reports Arrangelcons
Diagnostic Instrumentation =~ -—---—-=-=-mmmmm-m--
Normal I nstrumentation
Engine Configuration Data Particulate Filter De-green Reset
Activate Outputs Recalibrate NG Oxygen Sensor

MBE Progressive Shift Calculator
ServiceRoutines e
Options

View Observed Mids

Help
Help Topics

DDEC I1, 111, 1V Troubleshooting
DDEC V Troubleshooting
DDC Mechanical Troubleshooting

MBE Electronic Troubleshooting

About Detroit Diesdl Diagnostic Link



USING THE CONNECT ICON ON THE TOOLBAR

While the features in this document are normally located by their position in the drop-down menus, there is one option that
exists only as an icon on the toolbar: the connect icon. In the past users who had selected certain interface choices could
only run the DDDL application when hooked up to a“live” ECM. If they tried to open the application when not connected
to a vehicle the program would stop loading, an error message would be displayed, and the user would be sent back to the
Windows desktop.

1. In DDDL 4.2 or later the user will now get the following message:

Cannot initialize the following interface hardware [emrar 142]:

CDEC Multilink, Translatar, CORM1

Check that your hardware iz conhected and that the Optiohz are carrect,
Y'ou can change your options from the Start men in the following wan;
Start/Programs/Detroit Diezel/0phionzdnterface

DODL will be in OFFLIME operation.

T run the program in onling mode, you may puzh the connection button or restart the program.

(€ Copynght AUUZ Detroit Diesel Corporation Version 4.7

File Calibration Snapshot  Diagnostice  Tool:  Window  Help

(6|~ 75| 2] #] #|=| 2| 71| e|[[NoCodes J[ _offiine ]
-

2. When the user acknowledges the message the program will continue to load and the user may work in an offline mode.
If the user wishes to connect to avehicle later in the session he can do so without re-starting the application by selecting the
new connect icon in the toolbar.



USING PASSWORDS IN DDDL

ECM settings are protected by passwords. When using Detroit Diesel Diagnostic Link to change settings, you must enter
the appropriate password within the program before you can transmit the changesto the ECM. There are four different
types of passwords for DDEC. For the MBE system VCU software level 13 and later supports a calibration password to
protect all VCU parameters. When you go to the DDDL calibration drop-down menu the “Passwords’ selection is now
active and this Window will appear when it is selected. Beginning with DDDL 6.0 there is a backdoor password access
function for both DDEC V and the MBE calibration passwords.

1. TheCalibration Password is used to protect most of the calibration settings in the ECM.
2. TheRatings Password gives additional protection to the rating setting. The rating you choose can have major
consequences on engine life as well as performance. Y ou must enter both the calibration and rating passwords to

change the rating.

3. The Group L ockout Password allows an administrator to choose specific parameters for protection with an extra
password. Y ou must enter both the calibration and function lockout passwords to change the functions locked out.

4. Thelnjector Calibration password protects the flow calibration of the injectors.

5. The Backdoor Password function generates a special code to be used in conjunction with your local DDC distributor
or DDC technical service to unlock forgotten passwordsin DDEC V or MBE systems.

CHANGING THE CALIBRATION PASSWORD (DDEC)
x

—Fassword to Change

Old Calibration Fassword: R T ——

Mew Calibration Passwaord: ® Sy Passieie

¢ Group Lockout Password

Canfirm Mew Passwaord:

] Cancel Back Door...

The calibration password enables you to change the calibration in an ECM but not the engine rating or function lockout. To
changeit:

1. Choose Passwords from the Calibration menu to display the Change Password dialog box.

2. Typethe old password into the Old Calibration Password box. For password security, the numbers you type will not
be shown on the screen when you type in passwords. Only “*” symbols will appear.

3. Typethe new password into the New Calibration Password box.
4. Typethe new password into the Confirm New Password box to verify that you typed it correctly.

5. Click on“OK" to close the dialog box and set the new password.



CHANGING THE INJECTOR CALIBRATION PASSWORD (DDEC ONLY)

The Change Injector Password dialog box is displayed when you click on Change Password in the Injector Calibration
dialog box.

4.

Change Injector Password

Old Passwaord: II

Mew Fassword:

Confirm Mew Password:

=]|

)8

Cancel

Type the old password into the Old Password box. For password security, the numbers you type will not be shown on
the screen when you type in passwords. Only “*” symbols will appear.

Type the new password into the New Password box.

Type the new password into the Confirm New Password box to verify that you typed it correctly.

Click on “OK” to close the dialog box and set the new password.

CHANGING THE RATINGS PASSWORD (DDEC ONLY)

To change the password that enables you to alter the engine rating:

1. Choose Passwords from the Calibration menu to display the Change Password dial og box.

2. Click on the Ratings Password radio button to open the dialog box entering a new ratings password.

Change Pazsword

Calibration Password:

Old Rating Passward:

MNew Rating Password:

Confirm Mew Password:

Ik,

]|

—Password to Change

" Calibration Fasswaord

* Batings Passward

¢ Group Lockout Password

Cancel

Type the calibration password into the Calibration Password box.

Type the old ratings password into the Old Rating Password box.

Type your new password in the New Rating Password box.

Type the new password into the Confirm New Password box to verify that you typed it correctly.
Click on “OK” to close the dialog box and set the new password.
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SETTING THE GROUP LOCKOUT PASSWORD (DDEC ONLY)

To change the password that enables you to lock out (protect from being changed) selected calibration functions:
1. Choose Passwords from the Calibration menu to display the Change Password dialog box.

2. Click on the Group Lockout Password radio button to change the dialog box so that you can enter a new group lockout
password:

Change Pazsword E |

Calibration Passwaord:
—Fassword to Change

Old Lockout Fassward: ¢ Calibration Password

Mew Lockout Fassword: € Betings Password

(o égruup Lockout Password

Canfirm Mew Password:

Ik, Cancel

3. Typethe calibration password into the Calibration Password box.

4. Typethe old group lockout password into the Old Lockout Password box.

5. Typethe new password into the New L ockout Password box.

6. Re-typethe new password into the Confirm New Password box to verify that you typed it correctly.

7. Click on“OK" to close the dialog box and set your new password.

10



USING FUNCTION LOCKOUT
(WITH DDEC 111 REVISION 4.0 AND LATER SOFTWARE)

The Lockout tab in the Calibration window allows you to protect certain functionsin the ECM. These functions can only be
changed if you enter the function lockout password in addition to the calibration password.

ik Retrieved Calibration

Vehicle 1] Shift ~2| Protection *3| ISD & VSG “4| Cruise 5| vS§ 6 |
Speed Limit*7|Compressor *8| Econ 8 ESS 9 Lockout  “0 | Misc  *1 | Limits  “2 |

Idle Shutdown M Progressive Shif r
WSG Calibration r Engine /%ehicle Options [
Engine Protectian r Engine Droop r
Cruize { Speed Limits ~ Air Campressar r
ESS Transmissian ~ haintenance Alert r

Disahle DDEC Data Fages

Group Lockout Fasswaord |

Password : I Flesturel Reset | Iransmit Close

If the ECM supports function lockout, the Lockout tab will show the current lockout settings when the calibration is
retrieved from the ECM.

The settings in the Lockout tab affect the settings you are allowed to make in other tabs. If the lockout tab shows you are
locked out of a particular function, you will not be able to changeit.

To change the functions locked out in the ECM:

1. Typethelockout password into the Group Lockout Password box. This enables the check boxesin the tab. Y ou will
check and uncheck boxes by clicking on them with the left mouse button.

2. Put acheck mark in the box of any function you want locked out. Make sure there is no check mark in the box of any
function you want to allow others to change.

3. Enter the calibration password in the Password box.
4. Click on“Transmit” to send the new lockout settings to the ECM.

Note that the group lockout password unlocks all of the functions, so once you have entered it, you can change any of the
calibration settings in the other tabs, whether they are locked out or not.

11



USING THE BACKDOOR PASSWORD FUNCTION FOR DDEC V

In prior versions of DDEC backdoor passwords have been generated through a process not involving DDDL. Beginning
with DDEC V there is a new process where information from DDDL will need to be supplied to your DDC Distributor or
DDC Technical Service in order to generate a backdoor password. Follow these steps to generate a backdoor password for
DDEC V:

1. Write down the full engine serial number displayed in the “ Engine Configuration Screen” when you first connect with
DDDL. You'll need thisinformation later.

2. From the Cdlibration drop-down menu, choose the “ Passwords” selection, and then choose the “Backdoor” option in the
lower right side of the screen.

3. A screen will appear with a number as shown below:

Seed to get Back Door Password x|

If you hawve forgotten your password there iz a Back Door Pazssword
capability for the DDEC Y, Faollow the steps below o obtain the
pasaward,

Seed | CCCFFGTG

1. Becord the ''Seed" in the bax above.

2. Do nat run the engine as that would cauze the
pazsword to change.

3. Contact your lozal Detroit Diesel diztributar's zemvice
department and give them the Seed to get the Back Door

Paszword.

Follow the on-screen instructions. When you have the backdoor password you may insert it for any function that
callsfor apassword.

Please note that this password will only be good for one engine hour. Once a change in engine hour s occurs a new
password must be generated.

12



THE CALIBRATION PASSWORD FOR MBE

V CU software 13.xx and 14.19 allowed users to set up VCU password protection. This password option protected all
parameters in the VCU with a single password. Beginning with version 14.20 users may now protect certain parameter
groups with an additional password levels.

MBE Engne C |

VLU _PLD Properties |

Engre Series |MEE 300 (5]

Engne Serial Mo IE":IEEI'I 900 396859
Engne Model IEIEIE

WIN |EIEIEIEIEIEIEIEIEIEIEIEIEIEIEIEII]
ERa Certification |9EIEL.-'-‘«_EI¢1.3_1 90,0520

& Code WCL I.-’-'-. 000 446 36 35
PLD I.-’-‘-. 0E1 447 36 40

Softaare YWersion WICL 14.20

FLD Bl
Diagnosis Yerzion WL 153

11

LD

Print | Close |

Special Note: VCU software versions prior to 13.xx contained no password options.
The levels available and the parameters they protect are:

Level 1 —All VCU parameters

Level 2 — Maintenance Alert / Optimized Idle parameters

Level 3 - Low Gear Torque Limiting and Progressive Shift

Level 4 — Limiters (Parameter Groups 3, 5, 6)

Level 5—-PTO/ Idle Shutdown parameters

Level 6 —1/0 Configuration, Engine Protection, Fan Control, Engine Brake, Trans
Type

Level 7—TBD at alater date

13



To set up any of the above levels of password protection for aVVCU select the calibration drop-down menu and choose
“Passwords”

i Detroit Diesel Diagnostic Link

File | Calibration Snapshot  Diagnosticz  Toole Window  Help

Retrieve
|njectar...
E et

St Tratle..
Set ECM clock. ..

You'll be taken to athe password setup screen:

MBE Password Change

— Select Pazsword Level to Change
% Level 1 - Fleet Pagsward
O Level 2 - MAS/0I/SC Password
" Lewvel 3 - Low Gear Torgue Limiting and Progressive Shift Pazsword
" Level 4 - Limiters Pasaword
" Level 5 - PTO/Shutdown Password
i~ Lewvel 6 - /0 config, Engine protection, Fan contral, Engine Brake config, Tranz pe Passwaord

i~ Level 7 - Password

—Lewel 1 - Fleet Pazsward

Qid I MHew I Confirn Mew I
Apply | Cloze | Back Door... |

MBE passwords may be up to 10 numbers. There are no letters allowed.

In using the password management screen the “Old” password will be grayed and only the “New” and “ Confirm New”
boxes will be activeis a password for thislevel has not yet been set.

Qld I MHew I Confirmn Mew I

D'a not zupply ald
paszword Apply |

|'|_E'-.-'E| 3 - Lowe Gear Torque Limiting and Progreszive Shift Paszword

Cloze | Back Door... |

If there is already a password set for a particular level, you will need to enter the old password before being able to change
to different password.

14



When making changes to a VCU parameter with more than one password level, the user will be prompted to enter both
passwords before sending the change.

VCU Group 3 - Common Limiters

tdinimum Engine Speed

Engine Speed Limit w
baxirmum Adjusted ldle

Maxirmum Torgue Engi

VCU Group 5 - Limite
VCU Group b - Limite

15



USING THE MBE BACKDOOR PASSWORD FUNCTION

There are occasions when the existing password needs to be bypassed. It may be a case of the password being forgotten or a
used vehicle has been purchased with an existing password. To get the “ Backdoor” password to bypass the existing
password follow these steps:

IMPORTANT NOTE: ONCE YOU HAVE BEGUN THE BACKDOOR PROCESS DO NOT TURN OFF THE
IGNITION. THE NUMBERS YOU ARE GENERATING WILL CHANGE AND YOU WILL HAVE TO START

OVER.

1. Write down the full 14-digit engine serial number displayed in the “Engine Configuration Screen” when you first
connect with DDDL. You'll need thisinformation later.

2. From the Calibration drop-down menu, choose the “Passwords’ selection, and then choose the “Backdoor” option in the
lower right side of the screen.

3. A screen will appear with 2 numbers:

MBE P »
S T —— x| x|

— Select Pazs

IF pou have forgotten your pazsword there iz a Back Door
" Lewel1 Paszwaord capability for the WCL. Follow the steps below to
obtain the password.

A -1390672637 B: 13811

1. Becord the numbers in the boxes above.

2. Do nat turk off the ignition; the passward you obtain will
anly be good for thiz ignition cycle.

3. Contact vour lozal Detrait Diesel diztributar's zervice
department to get the Back Door Paszword.

—Lewel 1 - Fle
Enter Back Daoaor Pazsward ta Unlock,
Qi I

S ubrnit | Cancel |

ck Doar. .

4. Y ou now need to contact your local Detroit Diesel distributor or Detroit Diesel MBE Technical Service person with the
complete engine serial number, the 2 numbers in the Backdoor password box. They will be able to provide a number to
place in the section for unlocking the module.

5. When the password has been entered, click on the “ Submit” box and you should see the following message:

DDDL x|
& The Back Door Password has been accepted,

It is niow possible to change passwaords without requiring the old password to be entered,

This state is walid For duration of ignition cycle.

16



CHANGING DDEC CALIBRATION PARAMETERS

DDDL is equipped with capabilities to reprogram portions of the calibration in the ECM. The following list contains many
of the parameters that may be adjusted with DDDL. Parameters on thislist may be revised in new releases of ECM
software.

- Change DDDL calibration configuration password

- Add and or delete idle shutdown; set the idle shutdown timer
- Change droop

- Set the initial speed if cruise control switches are used as a power take-off option
- Set VSG droop

-Enable and or disable cruise control

- Add and or delete a vehicle speed sensor

- Change vehicle speed limit

- Change cruise control speed limit

- Reconfigure engine protection features

- Set VSG maximum speed

- Switch between available engine ratings

- Enter injector calibration

THE DDEC CALIBRATION WINDOW

iz Retrieved Calibration
Speed Limit “?lCumpressur “BlEcun & ESS “!]l Lockout “0 | Misc 1 I Limits "2 |
Vehicle  “1|shift *2| Protection “3|1SD 2 VSG “4| Cruise 5 | vsS 6 |
—\ehicle Identification Engine Serial Mumber—
Yehicle |dentification Number I
S |
Yehicle Unit Mumber IDDDDDDDDDD
—Idle Adjust and Droop Engine Zervice Brake
ldle Adjust RFR: |0 3: -25..100 ™ Engine/Service Brake
LSG Droop RPM: [128 = 0.150 tinimum mph: 0 — 0..40
Half Engine Mode it Cold = AdcFan Timer (s): 150
Password : I Hestore | Heset Transmit Close

The Calibration window is displayed when you choose New or Open from the File menu to create a new calibration or open
apreviously saved one, or Retrieve in the Calibration menu to download the calibration from an ECM connected to your
PC. Thewindow allows you to examine and set the calibration of an ECM connected to your PC. The calibration window
has a number of different pages labeled by tabs at the top of the window:

Note that the calibration parameters available depend on whether you are using aDDEC |1, DDEC |11, DDEC 1V, or DDEC
V. Note also that for DDEC |11 the Vehicle Unit Number is separate from the Vehicle Identifier that you can set and view
in Detroit Diesel Communications but that they are the same for DDEC IV and V.

The controls may be:
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1. Enabled and editable - The values are shown as black text against a white background with a black caption
2. Enabled and read only - The values are shown as black text against a gray background with a black caption
3. Disabled - The values are blank against a gray background with a dark gray caption

Controls may be disabled if you are connected to an ECM that does not support that feature or if it depends on some other
control, such as a check box, that has not been selected.

Toview the different pages of data shown in the window:

Click on the tab labeling the page holding the data group, or hold the Control key down while you press the number key
shown on the tab.

To closethe Calibration window:
Press Close or choose Close from the File menu.
Although they are concerned with different types of data, you will use the same techniques to set values in most of the

pages. Rather than presenting separate details for each page, changing the Calibration gives you genera instructions for
changing the calibration. Please note the Lockout tab is different and is described separately.
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CHANGING MBE CALIBRATION PARAMETERS
The MBE Calibration Window

There has been amajor change in the way parameter changes are to be made in DDDL 6.0 and in &l future versions of
DDDL in the MBE calibration window. When you retrieve a calibration from an MBE engine the parameters will no longer
be divided into groupings on separate tabs but only appear as a numerical list of parameter groups. Y ou may navigate
through the group structure in much the same way that you navigate through the folder structure in Windows Explorer. The
figure below shows a dlice of the retrieved calibration.

Parameter List “1 ‘

[ |index | Name [ value Uit [ Min | e
Cam | ¥CU Group 8 - Yehicle Speed Sensor
Cm | VYCU Group 10 - Engine Brake

[:I YCU Group 11 - Accelerator Pedal

¥CU Group 13 - Inputs

B L T e R BRI

Cm | ¥CU Group 16 - Relay 1/Starter Lockout
+ [ YCU Group 17 - Idle/PTO Shutdown

To get to the parameter value you wish to change, scroll down the group list till you find the group you wish to work with
and click on the “+” in front of the group name. The parametersin this group will become visible; the key 5-digit number is
displayed to the left of the parameter name. Parametersdisplayed in lighter gray type arefor informational purposes
only. Parameter settingsthat may be changed arein black type. Parametersfor the PLD and VCU are identified using
specific numbering system. Parameter settings are normally referred to by afive-digit value such as 10202. The parameter
listin DDDL contains settings for the both the PLD and VCU (for complete parameter lists of PLD and VCU default values
see the MBE Electronic Controls Information appendices). To understand what the values in the 5 digit parameter number
represent please review the figure below:

This value indicates
what group should
be looked at.

Thisvalue o
identifiesif the Thisisthe parameter

parameter is - ¢ number within the
fromthe PLD 1 group.
(0)orVCU (1)

To change a parameters click on the “Value” column and insert the numerical value or select the choice from those in the
drop-down menu that appears.

+-23 ¥CU Group 13 - Inputs

-3 VCU Group 15 - Cruise Control |
[ 11501 | Minirmurn Road Speed for Cruise Contral 30 mph 24 94
(9 11502 Maximum Set Speed for Cruise Contral IE _|: mph 30 34
[ 11507  Enable Cruise Auto Resume dizable
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Follow the figures below to see how the new password feature will appear to users changing parameters. Retrieve the
calibration in the usual manner and locate the item (or items) you wish to change, change the figure to the appropriate
value and click on the “ Transmit” box.

:Retrieved Calibration =gl =l
Parameter List *1 |
= | Inclex | MName |‘\falue | Unit =]
+ [0 Y¥CU Group 7 - PTO Control on PTO and CC pin
-3 YCU Group 8§ - Vehicle Speed Sensor
[ 10801  “ehicdle Speed Sensor magnetic pickup wehicle s...
[ 10803 Axle Ratio 3.790
(3 10804  Mumber of Output Shaft Teeth 1k
[ 10805 Tire Revolutions per Kilometer 1. Im j 1/kmgh
[ 10806 Top Gear Ratio 0.740
[ 10807  Second Highest Gear Ratio 2.550
[ 10808  GearRatio Tolerance 2.00
[ 10808  Two Speed Axle - Second Axle Ratio 4.100
(9 10810 Anti Tamper disabled -
4| | LI_I
2. | Transmit | Close |

If the password protection feature has been enabled, the enter password window will appear over the calibration list. At this
point, enter the appropriate password to proceed. Once the password is entered click on the “OK” box.

rEcRetrieved Calibration -0l x|

Parameter | ict *1 I

Calibration Parameter Unlock |
= N =l
123 VL Password  Function

S | VCL IT Lewel 1 - Fleet Password
(4 10801 | wet
[ 10803 | Acxle
[ 10804 | Mur
[ 10805 Tire /h
(3 10806 | Tog
[ 10807 | Sec
[ 10808  Ges:
[ 10809 | Twe

(1 10810 Ant =
N _>I_|

|

If the correct password is entered the password window will disappear while the changes are sent to the controller. This
window will pop up on the screen for avarying length of time depending on how many changes were made. The user will
then be prompted by anew dialog box appearing over the calibration list to turn off the ignition.
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Sending Data

Sending data ko the ECk

Turn ignitian affl

Once the ignition is turned off, a countdown proceeds on the screen until anew screen appears prompting the user to turn
the ignition back on. At this point the change processis complete.

Sending Data

Sending data ko the ECk

Committing.. ¥ seconds o go..

After asuccessful change has been made a screen will appear asking if you wish to save the calibration. This gives you the
option to save the calibration to your hard drive. If you don’t want to save thefile, click once with the left mouse button on
the “No” option and the processis complete. Click once on“Yes’ to savethefile to the hard drive. Choosing “Yes’ or
“No” to this question has no effect on the change you just transmitted. It only affects whether you save the contents of the
calibration as afile on your hard drive.

DDDL =]|

W arning.
T hiz Calibration has unzaved changes.
Do pou wizh o save the changes before exiting?

Mo Cancel

It should a so be noted that the groups and numbers within the groups have changed completely from version 12 to version
13. The number of parameters that are capable of being changed by DDDL has also expanded with version 13 software.
The numbering scheme for parameter groupings remains the samein VCU 14 software. Additional features have been
added to version 14 that have previously been only available in DDEC software including:

a. Pass Smart

b. Fuel Economy Incentive

c. Cruise Power Rating

SETTING INJECTOR CALIBRATION CODES (DDEC ONLY)
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When new injectors are installed in a service action, you should reset the calibrations for the injectors.

1. Choose Injector from the Calibration menu to display the Injector Calibration dialog box. It will show the current
injector calibration values. Move the up/down arrows of each box to show the new values.

2. Enter theinjector calibration password.

3. Transmit the changes to the ECM.

Injector Calibration

|

Cylinder #1 Change Password
Cylinder#2  [19 2 IM
Cylinder#3 |4 =
SAEEL ° - [rEfistit |
Cylinder#s |0 =

Erint |
Cylinder#6 |6 =

The cylinders for the other ECMsin multi-ECM engines will be shown below the master ECM block cylinders.

SETTING INJECTOR UNIT PUMP CODES (MBE ONLY)

The unit pump on MBE engines has a specific 14-digit value stamped on it as shown below:

A 028 074 69 07 [l
SE 9401 \
9 449390 13 00936

000 0

M1 7SS 8-

e [T =

0O 414 799 008
5237305

1. The number has always been on this particular part however with the release of the 2004 MBE enginesthereisa
requirement to enter this information when the unit is replaced. Y ou may use do this with the Programming Station, Detroit
Diesel Diagnostic Link, or the Minidiag. The routine to perform this operation in the Minidiag is called “Routine 006 -
pump line nozzle change”. To enter the value with DDDL choose the “Calibration” drop-down menu and select “Injector”.
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iz Detroit Diesel Diagnostic Link
FiIelCaIihratiun Snapshot  Diagnostics  Tools  wWindow

E Passwords. .. .l.lﬂﬂﬂ

Retrieve

Ratifg .

audit Trails, .,
Sek ECM clock, ..

2. The screen to enter the proper value will appear:

Set Injector Classification

Fleaze enter injgctar pump code, e.g. 5-083-868-26-00027

Cylinder Injector pump clazsification code

O NN .

Cahcel |

3. Select the cylinder you will be performing the replacement on and then insert the value shown on the unit pump. It
should be noted that in that the reference to the cylinder is the cylinder’s physical location and not the firing order. Also
note that if an incorrect sequence of numbers is entered you may receive a message informing you that an incorrect value
has been entered. Once the compl ete val ue has been entered, click on the “OK” box and you’ |l be prompted to recycle the

ignition so that the change may take effect. Upon sensing the ignition has been turned off a countdown will appear on the
screen.

Committing changes...

9 zeconds remaining 12.0 & complete

Cancel

When the countdown is complete there will be another message asking you to turn the ignition back on. When the ignition
is turned back on the application will display another message informing you that the operation has been successfully

completed.
x

& Injector configured succesfully,
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RATING CHANGES (DDEC Il / DDEC IV / DDEC V ONLY)

To change the engine rating:
1. Choose Rating from the Calibration menu to display the Rating dialog box.

Rating |

EHF = Rated RFM PeakTorgue [ft-b] 22 Pk

' 3ERE1810 1350061200 Calibration Paszwiord
™ 3501810 13500 200 I““““
3301810 135061200 Rating Paszward

330435061810 13506EH 200 e

i~ Usze Discrete Inputs

Frint Trarsmit | Cloze I

2. Choosethe rating from the list available.
3. Enter the ratings change password.
4. Transmit the change to the ECM by clicking on the “ Transmit” button.

24



USING THE FLEET CALIBRATION (DDEC ONLY)

Thefleet calibration (fleet cal) feature allows the manager of afleet to create one calibration that can be loaded into many
vehicles of the same configuration. For example, afleet manager taking delivery of 50 new vehicles and making ten
changes to the calibration would have to make 500 individual changes with a Pro-Link diagnostic reader. With the fleet cal
feature, a manager can create one calibration with all 10 changes and make one download to each vehicle, accomplishing
the same task in less time with greater accuracy.

1. Retrievethe origina calibration from the vehicle and saveit to your hard drive. Y ou can now turn off theignition.
2. Make all the desired changes to the calibration on screen by going from tab to tab and typing in the new numbers.
3. Remove theindividual unit number and vehicle ID number in Tab 1, Vehicle.

4. Enter your fleet password in the box in the bottom left corner of the calibration edit screen.

5. Click on the File drop-down menu and select the Save Fleet Cal option. Save the newly created calibration with a
name other than name of the original calibration.

6. If you are putting the new calibration into the original truck in the same session, connect the translator box and PC to
the diagnostic connector. Turn on the ignition.

7. If you are starting a new session, start DDDL and connect the PC to the truck.

8. Open thefleet cal you just created by clicking on the File drop-down menu and selecting the fleet cal from the list of
files near the bottom of the menu.

NOTE: A fleet cal can be saved with a specific password. If the password stored in the calibration file is the same as that
stored in the ECM and no further changes wer e made, the calibration could be transmitted by anyone who need not be
aware of the password in the calibration. In DDDL versions 3.1 or later, the user may transmit the contents of the fleet
calibration without overwriting the current vehicle number and VIN number. In versions of DDDL prior to 3.1, the person
transmitting the calibration must know the passwor d because the vehicle ID and unit number need to be added and this
action requires the password

IMPORTANT NOTE: Steps 9 and 10 below must be completed if you use DDDL 3.0 (or prior) to insure the proper
vehicle ID and VIN number are entered when using afleet calibration. The fleet cal feature in DDDL 3.1 no longer writes
over the vehicle ID or VIN number aready programmed into the ECM.

9. After entering the password into the box at the bottom left corner of the window, type the new vehicle ID and unit
number into the box in Tab 1.

10. Click on the Transmit button at the bottom of the window. This sendsthe calibration to the ECM. The processis now
complete.

DDDL offersavariety of password security features to the fleet manager including Group Lockout and

Rating Change passwords. Please refer to specific sections of the Diagnostic Link help menu for more information on these
topics.
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USING THE SNAPSHOT FEATURE IN DDDL

Specia Notes: 1. All portions of the snapshot feature perform in the same manner for both the DDEC and MBE systems.
2. Snapshots created by later versions of DDDL may not play correctly in the earlier versions of DDDL. For example, a
snapshot created with DDDL 6.0 will not play in DDDL 4.1.

it Record Snapshot [ _ O] =]

Stop Recording ESC ark ser Event SPACE

00:00:03

"Flecord Time——————— Annotate... |

1. Choose“New” from the Snapshot menu to open the snapshot control window.

2. The snapshot feature begins immediately upon the appearance of the control window.
3. All eectronic engine data transmitted during the snapshot is stored for playback.

4. Any codesthat occur during the snapshot are automatically marked.

5. You may mark events any time during the snapshot with the user event button.

6. Beginning with DDDL 4.1, the user has the ability to add comments to the snapshot. Click on the “ Annotate” button
and awindow will appear alowing additional remarks about the current snapshot.

7. Hit the stop recording button to finish your snapshot.

8. A dialog box appears giving you the opportunity to save your snapshot. At this point you may choose a name for your
snapshot and the location to store it.

B. Toopen aprevioudy saved snapshot,
1. Choose“Open” from the Snapshot drop-down menu to display an Open dialog box.

Open EHE
Lookjn: | ‘3 Diagnostic =l W= =
s8] Log1.ddl
s8] Log2.ddl
s8] test. dd

File: narne: I Open I
Files of type: | Snapshot Files [+ DDL) =] Cancel |

2. Seethe next section on how to replay the snapshot file.
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USING SNAPSHOT REPLAY CONTROLS
When you have opened a snapshot, replay controlswill appear at the bottom of the DDDL window you opened:

Pla',r | 1 N 1 00:01:04 Annotation st time 00:00:00

| YEH PWR DOWN - open circuit j Edit... I

1. Start thereplay of asnapshot by clicking on “Play.” The play button changes to “Pause” when a snapshot is replaying.
While the snapshot is replaying, the replay slider next to the Play/Pause button moves showing the progress of the
replay, and the time box next to it shows the time since the beginning of the recording. When you click on “Play” the
snapshot beginsto play from its current position and the instruments show the appropriate readings. The event window
also changes during the replay to show the most recent event.

2. Stopthereplay at aparticular point of interest by clicking on “Pause.” The instruments will show the values at the
time the replay was stopped.

3. Beginning with DDDL 4.1, additional comments may be added to the snapshot while in replay mode. Click on the
“Edit” box and awindow will appear to add your remarks.

4. Moveto aspecific timein the replay by dragging the replay dlider button. Asyou drag the slider, the time shown in
the time box changes to reflect the position of the dlider.

Or,

5. Moveto aspecific timein the replay by typing the time you require into the time box. Make sure you use the same
format for the numbers as the box displays. Click on the “Return” key.

Or, to show the data at the time of a specific event,

6. Click on the event drop-down list box to display thelist.

Too few SRS [missing SAS) *

Baro. pressure circuit failed low
Coolant level low

Oil pressure circuit failed low
Fuel pressure circuit failed low

TPS circuit failed high
Too few SRS [missing SRS

The box shows the events generated by the ECM and those marked by the user in the order in which they occurred.
Select an event to move the replay point to the time at which the event occurred.

If the snapshot is playing when you move to a new position, it will continue playing from the new point. If the
snapshot is paused when you move to anew position, the instruments will hold the data for the new position until you
start playing the snapshot or move to another new position.

NOTE: Not all DDDL windows can be activated when replaying the snapshot feature. Windowsthat may be
activated include: the normal instrumentation window, the diagnostic instrumentation window, the graph
window, the user window, and the fault codeswindow. Y ou cannot access the injector response time window or
the cylinder cutout window in snapshot mode.
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CHANGESTO THE GRAPH TAB IN DDDL 6.1 AND LATER

In addition to the feature changes bel ow, the window that displays the numerical values that appear in the Graph window
now adjusts automatically to allow for more parameters to be viewed at once without scrolling down.

1. Saving User Selectionsin the Graph Window

D escription | Valuel Linits | Minl Maxi = tdodify I
=——RTC Backup Battery Yoltage 3E8 W n.an 5.00
— Average Fuel Econory 1.2 mpg oo 150 L
oad

Battery Patential 138 v i1 0.0 _—I
= Engite Oil Temperature -3 °F A0 300

EGR Temperature 70 °F a EO0 Save |
— Fuel Temperature A0 °F 50 300 _Y_] =

1 IJ 00:00:35 Annotation

IUser Event 4 _'] Edit... |

Beginning with DDDL version 6.1 users will be able to save and then load selected groups of
parameters when using the Graph tab in the Normal or Diagnostic Instrumentation panels. The feature
will work in the same manner asthe “Load” and “Save’ feature on the “User” panel.

“Modily graph page |
Ayallable Selected

Barometric Preszure ;I Accelerator Pedal Pog

Batterny Potential Boost Pressure

Bol Engine ECU Temp

Crankcaze Pressure Engine Oil Preszure

Cruize Chl Set Speed Sdd x | Engine Sensar Supply Yoltage

EGR Delta Prezssure

Engine Brake Percent

Engine Coolant Temp

Engine Oil Temperature
Engine Speed

Exhauzt Back Pressure

Fuel Delivery Prezsure

Fuel Filter Differential Pressure

Fuel Rate
Fuel Temperature
1Al- Eu-\.ﬂ:u-\.pn [ | LI

o |

EGR Delta Prezsure Counts
EGR Temperature <% Femove |

Exhaust Temperature

Cancel

Users choose the parameters they wish to view by clicking on the “Modify” button on the main Graph window and using
the “Add/ Remove” buttons. When the selections are finalized choose “ OK”.
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Save Graph Page Settings As

2l x|

Save in; I 5 Diagnostic

x|+ & e B

If you wish to save this
selection for future use
select the “Save’ box on

_1Data Pages the main Graph window

DIDCanig and select afile namein

CIREPORT the dialog box that
appears. The selection

12.usr may be recalled at alater
time by choosing the
“Load” box on the main
Graph window.

File: name: | Save

Save as type: ILlser Page Files [".usr)

ET
j Cancel |

i

2. ldentification of Diagnostic Codes and User Eventsin the Graph Window When in the

Snapshot Playback Mode

Power *1 |  Jake Brake-2 | Misfire 3 | Smoke “4 List 5 |
EGR “6 | ExhTemps“7 Graph “8 | User "9
marks of
codes and
user events
200 0:00
Description | Valuel Units | Minl Maxi = Modify I
—RTC Backup Battery Voltage 368 W .00 500
— Average Fuel Economy 7.2 mpg IR 15.0
Load
Battery Poterial 138 v 0.0 40.0 _ Lo |
= Engine 0l Temperature N °F A0 300
EGR Temperature 70 °F 0 &00 Save |
= Fuel Temperature 40 °F Rl 300 i

Users may now set up their snapshot replay mode so that diagnostic codes and user marked snapshot events will be marked
along the time-line at the top of the Graph window. Please note thisfeature only workswith snapshots created with
DDDL version 6.1 or higher.

To activate this feature select the “Modify” box on the main Graph window. When the window appears add the “Active
Code Count” from the “ Available” list of parameters along with the other parameters you wish to select and choose “ OK”.
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Modify graph page

Avallable

&ctive Code Count_|

actual engine speed

Actual engine torque(PLD ]
Actual governing zpeed
actual zpeed limit

Air Filter Differential Preszure
Air [nlet Pressure

Air-Flow Yoltage

ambignt prezsure

Ambient Pressure YWoltage
Analog Accelerator Pedal [AFPS]
Analog Remote Pedal [HFGS)
aurilary zpeed Terminal W
Ay, Fuel Economy

B arometric: Pressurne

B attery Patential

B attery Woltage

Demnb Ormmmn e PR F AWy

Selected

Acceleratar Pedal Poz
B oost Pressure
Engine il Pressure

Ald

[Active Code Count |

<4 Hemowe

[

o |

i

Cancel
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USING THE SNAPSHOT TO CSV UTILITY

Beginning with Diagnostic Link version 4.1, this feature allows users to view the raw data captured in aDDDL snapshot
inside a spreadsheet for advanced engine data analysis.

1. To begin the conversion of an existing snapshot to acomma separ ated variable datafile (csv file), go to the “ Snapshot”
drop down menu of Diagnostic Link and select the “ Snapshot to CSV” option.

i Detroit Diesel Diagnostic Link

File Calibration fgEega@ Diagnozticz Tool: 'Window Help
Bﬁlnl&l : Mew k4
= Open...

Cloze

User Event
Pauze
Snapzhot to C5Y

2. A dialog box will then asking you to identify the snapshot file you wish to convert. Select the file you wish to process by
highlighting it and select “Open”.

Look ir: |¢3 ENap_cEv j ﬁl
woutddl

«in_ddl

=] light.ddI

4| | o

File nane: Ifreewa_l,l.ddl Open I
Files of type:  [Snapshot Files (~DDL] = Cancel |

3. When afile has been selected, a new dialog box will appear allowing the user to set up the options for the csv output file.
The following items must be set up prior to creation of the export:

- Parameters to be listed (the user must specify)

- Export timeinterval (if only a portion of the snapshot isto be analyzed), value in seconds; by default the entire snapshot is
converted

- Sampl e frequency (this value may begin at .001 seconds and go up from there); the default interval is one second
- Sample format (3 types are available)
- Save-in dialog box to name the final output file and designate its location
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4. When all these items are selected, click once on the “Export” box, just to the right of the “ Save-in” dialog box and the
conversion process will begin.

E xport log file [.ddl] to .C5¥ hle EE
Ay ailable Selected
Aborted ESS Shifts -

Accelerator Pedal Pos

Air Inlet Pressure

Air Inlet Pressure - R1

Air Inlet Pressure - R2 EinleE |
Air Inlet Temperature

Air Inlet Temperature - B1
Arnbient Air Temperature SEEneE
A, Water Pump Press,

Barometric Pressure

Barometric Pressure - A1

B arometric Pressure - R2

Battery Potential

Battery Potential - R1

Battery Potential - R2

Blower Bypass Valve Pos

d

BOI
Db D, - LI
— Export Time Interval Sample Frequency Sample Format
Frari: ID I-] e :: Ene F'aramester pe&F!ohWé'Linel Puiod
* Parameters Seen Each Sample Perio
Te I‘HD ' Continuous Parameter Yalues

Save i IE shap_csv j ﬁl N

Cancel

File nare:

Save az type: II:SV Files [*.cav) j

5. When the export is completed the user will receive the dialog box below asking the user to verify that they want to save
the new csv file. Click on “Yes’ and the process is completed.

Export Sucessful
Do you wish to save the file?

Yes No

Please consult your spreadsheset’ s documentation for working with the csv output files.
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FAULT CODES AND DDDL

DDEC Fault Codes Window

The Fault Codes window is displayed when you choose “Fault Codes’ from the Diagnostics menu. Note that the screen
below shows the Fault Codes window for aDDEC I, IV, or V. See the note following the screen for differences when
you areusing aDDEC II.

Fault Description |Flash| EEMl |0 | Fhdl | Startl End | Diwration :| Start ... |Stu:u|:uTime| Min | Ma:-:l

:?: Qil pressure sensor - input vol... 36 Maz P 100 4 61 - 181215 Sepd..
Thrattle sengar - input voltag... 21 Maz P31 3 361 32 112111 Sep2.. Mowldd

< [+

Current Engine Houwrs: | 366 Troublezhooting Help | [Elean Selected Codes | Clear Inactive Codes | Elusel

Fault Codes Window Information (all versionsof DDDL)

- Thelight bulb symbol on the left indicatesif the codeis still active.

- The window displays both the DDEC flash code and the SAE code notation (SID or PID and the FMI). The engine hour
when the code first occurred is displayed.

- If the code is historic, the engine hour when the code last appeared is displayed as well, along with the total duration time
of the code for all counts logged.

- You may access the troubleshooting help guide for a particular code by highlighting the code you wish to work on with a
single left mouse click and then selecting the Troubleshooting Help option.

Fault Code Window Featuresin DDDL 4.1 and later

- Time stamps are included for the beginning and ending of each fault code.

- Current engine hours have been added to the Window.

- Certain parameters will display a minimum/maximum value attained during the time the code was active.

The Fault Codes window with a DDEC |1 - The DDEC || ECM does not allow you to clear individua codes, so when
you are connected to a DDEC |1 the Clear Inactive Codes and Clear Selected Codes buttons are replaced by a single Clear
All Codes button.

To clear dl the codesfrom aDDEC || ECM, click on the Clear All Codes button.
Snapshots - If you have opened a snapshat, the replay controls are added to the bottom of the Fault Codes window when it
isselected. Thisway you can monitor fault codes produced during the snapshot. When the window is used for a snapshot,

the Clear Selected Codes and Clear Inactive Codes buttons are hidden since these operations are only relevant when you are
connected to an operating ECM.
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Saving diagnostic fault codes to afile.
Diagnostic Link now allows you to save diagnostic codes to a file.

From the fault code screen, select the fault code(s) you wish to save and click on the Copy button. You can
select one code at a time by depressing your CTRL button and using your mouse to right-click on each line.

H Detroil Diesel Disgnostic Link

[Fied Dasciion TPk Twcsa Ty T vt T e [ it | Cortion | Court [ 0t Ve [
W o ot B3 V5 e 2 w ST 4 [] Myl Y

Ocdld Detban

& AeE1S00 D0
Ml §

0 e =

"
"
"
"
"

A 04 govtore o gt veka 36
T —
< ¥
Camer Engr

[ an Troubisshosing Hep Coy | Do

@

For Help, press F1 SOMNICTID

Open notepad or MS Word and select paste. Select Save As from the File menu and type in the This is an
example of how the data will appear in notepad. From here the data can be archived, printed or emailed.

B Untitled - Notepad Save As Rx

b E el G i Savein: | () My Documents v @2 m
[AcTIVE] Aux. output #3(E49) - Engine Brake Low - open circuit
Flash: 31 m I Blustonth Exchange Folder
ECM: Mas { |2y Migration Lost and Found
Ib: 5 91 My Fecert | [C2My eBooks
FMI: 3 Documents |2y pusic
Asg _ 2} My Pictures
End: —- . e @ P b1y videos
Duration: 18:12:15
count: 1 Deskiop [Ehterrywison
Start Time: Mow30,11:20 EWE"EX
vy

stop Time:
Extreme;
overrides:
[ACTIVE] Baro Er‘ess sensor - Tnput voltage low
Flash: &7
ECM: Mas

My Documents

FMI: 4 My Camputer

puration: 16:12:15 File nsme: [FauCodedea v  [save ]
Count: 1 1

Start Time: Mow30,11:20 MyMetwork | Saveastype: | Tt Documents [“bd] | [ cancal |
Stop Time:
Extreme: 0.0psi Encoding [ansI |
overrides: 0

The Copy button is only enabled when at least one fault code is selected.

M BE Fault Codes Window

Theinformation shown in the fault codes window is not afunction of DDDL but a function of the information being sent
by the electronic control unit. The basic information displayed in the MBE fault codes window is limited to the code
identification and the number of counts for that particular code. Additional information as such as the time and date
stamping the fault code start, finish, and total duration is not available.



1 Fault Codes | (O] x|

| D | Frdl | Start | End | Diuration | Count | Start Time | Stop Time |A
F a1 4 il
558 5 1

Fault Description
;?;Accelelator Fosition Percent ¥
Aur Pibd #2 Low Side Line 5.

il

Clearlnactivecodesl _

-

M 4

4| : |

Current Engine Howrs: IUU—
| |
Useful facts to remember when using the MBE fault codes window:

Troublezhooting Help | [tean Selected Codes |

1. Active codes are identified by the red light to the left of the fault description.
2. MBE fault codes are identified by standard SAE PID or SID numbers and their companion failure mode indicator (FMI).
3. There are no flash codes identified with the MBE system.

IMPORTANT NOTE ON MBE ELECTRONIC TROUBLESHOOTING
Beginning with DDDL 6.2, an in-depth troubleshooting tree for the MBE system is now available. | n versions prior
t0 6.2, “ Troubleshooting Help” will only link to complete code description list.

IS[=] E3

<> Troubleshooting Help
File Edit Bookmark Options Help
Qontentsl Index | Back | Print |

Although a troubleshooting
tree was not availablein

« [ = |

MBE diagnostic code definitions
The table below lists all the supported fault codes for MBE electronics in Diagnostic Link:

Jump to Sid codes I Jump back to Pid codes I

versionsprior to 6.2,
additional MBE information
isavailablein the MBE
Electronic Controls section of
Help and on the DDDL CD-

Pid/  Identifier FMI Description = ——

Sid ROM. Thismaterial includes
pin-outs, wiring diagrams,

i’ and information on the

oper ation and setting up of

P 45 5 Flame Start Gate Open Circuit . D 9 D.
important MBE electronic

P 45 4 Flarme Start Gate Shorted to Ground
features.

P 45 14 Flame Start Gate Special Instructions

. g4 = Yehicle Speed Sensor Open Circuit

. o4 4 “ehicle Speed Sensor Shorted to Ground

= N . Accelerator Position Percent Data Erratic

- 9 = Accelerator Position Percent “oltage Above Marmal or Shorted to High Source

B N 4 Accelerator Position Percent Voltage Below Mormal or Shorted to Low Source =

KN 1L
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DDEC CYLINDER CUTOUT BASICS

Cylinder Cutout
The cylinder cutout test Colinder  Pulsswidth & RFM Cylinder  PulssWidth @ RPM s e
Can be avqy US.er| tOOI #1L 0.0° G 0ooo #1R 0.0% @ 000a
for daermlnlng If an #aL 0.0° G 0ooo #2zR 0.0% @ 000a }
injector is mafunctioning. ' ' Manual €
The test can be run in #aL 0.0° G 0ooo #3R O 0.0% @ 000a
“ Automatic” mode, which oL 00" (@ LoD HR € WE U g ey
performs the cutout on 1l -
each cylinder in succession 1000 BPM &
or in the“Manual” mode Frs BPM £
where the user selects a _
specific cylinder prior to
testing. To perform a
cylinder cutout test with figure #1 [ e
DDDL, follow this Bint |
procedure:

Test Results
’7N0 Teztz Perfformed

1. From the Diagnostics drop-down menu select the “ Cylinder Cutout” option. The cylinder cutout screen in the figure
above will appear on your screen.

2. Fill inthe options on the cutout screen for the type of test you would like to run.

3. Runthetest. When thetest results are complete (see the figure below) it isagood ideato print them. (If you are not
connected to a printer, see the section on how to print offline.)

4. For aninterpretation of your results, check the Mechanical Troubleshooting section of Help. This option will supply
further information on cylinder misfire due to a faulty fuel injector.

Cylinder Cutout

Cylinder  Pulzetwfidth & RPH Cylinder  Pulse'width & RPk — Test Type

L 107 @ 999 #R O 123 @ 999 Automatic

Hal NE@ 399 #R 141°@ 999 el

HaL 123 @ 999 #3p O 1m0E 339

HaL O 137 @ 999 #4R O & 83 Test Speed
Idle -
1000 BPM (+
Eree RPM

Cloze

figure #2

_ e |
[ Bz

Print

Test Result
Baseline Pulsetidth 13.0° & 993
Test Completed
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MBE CYLINDER CUTOUT TEST BASICS

To start a Cylinder Cutout Diagnostic Test:

1. Theengine must be on.
2. Theengine must be at idle (no other option is available).

Thistest continually measures the torque of the engine. When a designated cylinder is switched off, the
injector is disabled causing the engine speed to decrease. The remaining cylinderswill correct for the
missing cylinder and return to the correct idle speed. The change in engine torque will indicate the power
loss of a particular cylinder. A low change in engine torque may indicate a faulty cylinder.

Notes on MBE cylinder cutout:

1. Thistest will check the baseline torque prior to each cylinder being cutout, unlike the DDEC test
that only makes an initial baseline measurement. Because of this, the test will take longer to run
than a DDEC cutout test.

2. Theresultsof thetest should be evaluated by therelative torque value of each cylinder (not
the baselinevaluein the lower Ieft of the window). A significantly lower valueindicatesthis
cylinder may have a problem.

3. In Automatic mode, the test runs through each cylinder one at a time and measures the torque as
each oneis switched on and off.

4. In Manua mode, the user may switch the selected cylinder on or off as desired. The torque will be
measured in the same manner for both types of tests.

5. Upon exiting the test, all cylinders are automatically turned back on.

Below are the results of 2 tests. The first test shows al cylinders working correctly. The second indicates a
problem with cylinder #1.

Cylinder Cutout

Type Test Tupe

Cylinder Tarque deviation =2 BPM Done
. . Sutomatic

#1 T 2900Nm@ B0 a
Manual
g2 O 2242Mm@ RIE a
#3 O ZE5E Mm@ RO0Z2 a
B4 O 2058 Mm@ BO9 & Test Speed
Idle (v
5 O 1983 Mm@ 595 a
e O 1867 Mm@ ROE a
Cloze
Frink
Test Resultz

B azeline Torgue 2.83Mm =2 603 RPM
Test Completed

Test one, with cylinders operating correctly.
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Cylinder Cutout

Test two, with a potential fault in cylinder number 1.



THE MBE SERVICE ROUTINES WINDOW

There are 5 diagnostic routines built into the PLD module. The cylinder cutout routine has its own menu
selection; the voltage test is located as atab in the diagnostic instrumentation window, while the remaining
routines (compression test, idle speed balance, and impact delay times) are contained in the service routines
window.

The Compression Test

x

Impact Delay Times I Idle Speed Balance  Compression I

Cylinder #1 |1 00.00 % Fun Test.. I

The compression test isa

Cylinder #2 |E|2.1 g% rel ative measure of
compression on all cylinders.

Cylinder #3 |E|E|.22 A The test selects the cylinder
with the “best” valueto

Cylinder #4 IE?‘.EE: -4 represent 100%. The valuesfor
the other cylinders are listed

Cylinder #5 IBS.EB # relative to cylinder receiving
the 100% rating.

Cylinder £65 IEE.EB 4

Print k.

Running the compression test:

1. To begin, select the “ Service Routines’ option from the Diagnostics drop-down menu; choose the
compression test tab

2. Make sure that the engine is turned off; then turn key to the “On” position
3. Click on the “Run Test” box

4. Crank the engine; the test is run during the cranking process, the engine will not start, when the test is
completed the results will appear.

Note: Thecranking timerequired to complete the test should not exceed 40 seconds. If the test results

do not display within this period, there may be other circumstancesthat are not allowing thetest to
be completed. I n this case, please consult Detroit Diesel Technical Support for assistance.
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Thelmpact Delay Time Test

x

Impact Delay Times | |dle Speed Balance I Compression I

Cylinder #1 (1508 us The impact time represents the
_ time from the actuation of the unit
Cylinder #2  |1535 us pump until the valve body is

recognized as being closed.
Cylinder #3 1520 us

The PLD measures these times

Cylinder #4  |1904 us continuously - the figures shown
in the dialog are the averages of
Colinder #5  |1522 us the most recent measurements at

the time the dialog box is opened.
Cylinder 5 1517 uz

EREEEE

Pt |[ ok ]

Theldle Speed Balance Test

x

Impact Delay Timez  |die Speed Balance | Compreszsian I
Smooth idling control is always
active. Theresults of the ldle
Speed Balance test shows for
each cylinder the deviation value
required to balance idle speed.

Cylinder #1 -0.04 &
Cylinder #2 (003 %

Cylinder #3  |0.05% A deviation of 5% or more gives

afault code of 128 00n 12, where

Cylinder #4 | 0.05 % nisthe cylinder number.

Cylinder #5  |[-013% Deviations at one cylinder only

suggest an error condition.

EELELE

Cylinder g5 |0.07 &

Pt |[ ok ]
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Proportional Valves

This new feature has been added as an MBE routine. It allows the technician to activate and
deactivate engine lamps and proportional valves for testing purposes. This screen is displayed
by selecting Activate Outputs from the Diagnostics Menu.

Tools  WWindow

Fault Codes F&
Cylinder Cutout, .

Diagnostic Instrumentation F5
Mormal Instrurnentation

Engine Configuration Data

Activate Cutputs, .,

Service Foutines, ..

Wiew Observed Mids

X

Activate Outputs (VCL)

Dutput to set; State to zet;
Fied Engine Lamp 0%
‘Yellow Engine Lamp 00
‘gt To Start =

Proportional Valve

Propartianal ¥ s

Proportional Valve 3
Proportional Valve 4
Proportional Yalve &
Proportional Yalve B

Click on the output to et and then choose the state to zet for

that output. States are et immediately.

Select the Output you wish to test and highlight it with a left mouse click. Set the state by clicking
on the appropriate radio button. 0% = Off 100% = On.

This list defines each Proportional Value.

Table
Proportional Valves
o
Valve  Signal Function Function Function Low Power
MBE 900 MBE 900 EGR MBE 4000 EGR  Side  Supply Pin
Non-EGR Engine Engine Control {Switched
Engine Pin VBat)
PY1  PWIDigital ExhaustFlap or ExhaustFlap or Wastegate 54151 55012
Qutput Wastegate Wastegate
Pv2  PWhiDigital Compression EGR Valve EGR Yalwe 54150 A5152
Cutput Brake
PY3  PWH/Digital Fan1 Fan 1 Fan 1 55141 5512
Qutput
P4 PWhIDigital Fan 2 Fan 2 Fan 2 55143 5512
Qutput
PYs  PWIDigital Unused Compression  Compression 55011 - A&12T - High
Cutput Brake Brake Ground  Side Control
PYE  PWIDigital Unused Grid Heater Turbo Brake or 55140 h5142
Cutput Exhaust Flap 5
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THE INSTRUMENTATION WINDOW

The Instrumentation window is displayed when you choose “Normal |nstrumentation”

or “Diagnostic

Instrumentation” from the Diagnostics menu. The window displays live data measurements from the ECM
connected to your PC. Thefirst picture below show the options available from the normal window. The

second shows the options available in the diagnostic window. The natural gas option was added to the
diagnostic window in version 4.10. The EGR window was added in version 4.20. The List window was

added in version 5.0.

DDEC Instrumentation Windows (Nor mal and Diagnostic)

pet Instrumentation =]
Mech *1 | Pres 2 | Temp ~3 | Ind-1 4] Ind-2 5 | ESS *6 | Turbo *7 | Graph 8| User 3 |
Engine Speed Wehicle Speed .&c:celeratol FPedal Poz 8%
oo 5" zooo
Loo 2500
o 3000
Blower Bvpass Yalve Poz 29%
624 rpm 11 mph
ldle Speed ipm | Cruize Conbrol Set S peed mph Toique Limiting Factor 100 %
COutput Torgue Inst. Fuel Economy erea Bl Loed 0%
500 laoa 5 10
0 1500 o T
=500 2000
Enaine Brake ulii
138 £t.lb 10.6 wpe
List 3 EGR “4 Exh Temps*5 | NatGas*6 |  Graph*7 |  User8 |
Fan *7 Misfire *8 Smoke *9  |SensorVoltages *]  CC/PTO*1 | Switches "2 |
Power *1 Jake Brake *2 Misfire *3 Smoke *4 | Power *5 | Brake “6 |
Engine Speed pm | Pulse Width TPS Counts Vehicle Speed
40 60
L E 720 80
11 mph
Boost Fressure
E H WSGE Counts Battery Potential
z0
o 1a 30 an
Percent Engine Load 2k
13.8 V
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DDEC Instrumentation Window Features

The normal instrumentation window is also displayed when you choose “Open” from the Snapshot menu
unless the Fault Codes window is already open.

When you have an open snapshot and the Instrumentation window is selected, playback controls are added
to the bottom of the Instrumentation window. Y ou can use these to replay the snapshot. The
Instrumentation window is used in the same way whether you are viewing live data or a snapshot.

Instrument Pages

The instruments in the Instrumentation window are grouped together on tabs. Y ou can choose how they
are grouped by choosing Normal Instrumentation or Diagnostic Instrumentation commands in the
Diagnostics menu.

To view the different pages of data shown in the window, click on the tab labeling the page holding the
data. You may also hold the “Control” key down while you press the number key shown on the tab.

Note that you can customize the information shown in the Instrumentation window using the Graph or User
pages.

Multi-ECM Engines

Provided you are using a PC display with aresolution of at least 800 X 600 (small fonts), some of the
Normal Instrumentation pages show details for each of the ECMsin amulti-ECM engine.

Note that whatever the resolution of your display you can also monitor parameters in the different ECMs by
assigning them to instruments on the User pages or by choosing them for display on the Graph page.

Instruments
The results of measurements are presented in avariety of ways, depending on the quantity measured.

You can tell from an instrument if the ECM is not transmitting data for that measurement. The way "No
Data" is shown depends on whether the instrument is:

- ameter

- athermometer

- adigital meter

- text

Magnified View of Instruments
To display a magnified view of just one of the instruments on your screen, click on the instrument to

enlargeit; click on it again to return it to the normal size. (thisis particularly useful if you want to monitor
ameasurement while you are working at some distance from the display):
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I nstrumentation Window for MBE

The Instrumentation window is displayed when you choose Normal Instrumentation or Diagnostic
Instrumentation from the Diagnostics menu. The window displays live data measurements from the ECM
connected to your PC. The Instrumentation window is also displayed when you choose Open from the
Snapshot menu unless the Fault Codes window is already open. When you have an open snapshot and the
Instrumentation window is selected, playback controls are added to the top of the Instrumentation window.
Y ou can use these to replay the snapshot. Otherwise, the | nstrumentation window is used in the same way
whether you are viewing live data or a snapshot.

Mech 1 | Pres *2 | Temp *3 | Status “4 | Graph & | User “6 |
Engine Speed Wehicle Speed Accelerator Pedal Pos 0%
1000 1500 zoog 40 60
ul] 2500 20 50
LY J
3000 0 100 |Flemote Accelerator Mo Dy
0 rpm 0 mph
Output Torque frlb [Maominal Engine Torqueftln | Eattery Patential |Engine Brake |Uff
10 20 a0
o £ A

za.1 -

Percent Engine Load 0%

Actual Engine Torque ftlb  |Max Momentary Torqueft. Ib

Clutch Cylinder Position 100 %

The instruments in the Instrumentation Window are grouped together on pages. Y ou can choose how they
are grouped by choosing Normal Instrumentation or Diagnostic Instrumentation commands in the
Diagnostics menu.

To view the different pages of data shown in the window: Click on the tab labeling the page holding the
data, or hold the Control key down while you press the number key shown on the tab.

Note: The pages are designed to cover all MBE configurations. This meansthat some instruments
may not show a value on your particular system becausethey arenot relevant to it

The following pages are available in the Instrument window for MBE engines:

Normal Instrumentation

Diagnostic Instrumentation

Mechanica Power
'Fljre&n:?)gri\ture E;?]ke Complete examplqsof the MBE
Status Misfire Screens appearing |n.the
Graph Smoke instrumentation section may be
found in the Help section of

User Sensor Voltages DDDL

Cruise Control / PTO '

Switches

List

Graph

User

EGR



Notes on MBE | nstrumentation:

1. The Graph and User pages appear in both the Normal and Diagnostic Instrumentation modes - they allow
you to customize the information shown in the I nstrumentation window.

2. The List tab alows you to view all the MBE diagnostic parameters in one scrollable list organized by
functional groups.

3. Thetab displays all the possible sensors that may be configured on a variety of MBE engine
applications. Some sensors do not provide data on some engine configurations. Please consult your engine
documentation or you Detroit Diesel engine specialist for specific details on your engine.

4. The results of measurements are presented in avariety of ways, depending on the quantity measured.

5. Aninstrument will show “No Data’ if for any reason the ECM is not transmitting data for that
measurement. The way "No Data' is shown depends on whether the instrument is:

- ameter

- athermometer
- digital meter

- text.

6. To display amagnified view of just one of the instruments on a data page (thisis particularly useful if

you want to monitor a measurement while you are working at some distance from the display). Click on the
instrument; click again to return to the normal size view.

45



ENGINE CONFIGURATION DATA

The DDEC Configuration Window

The procedure below allows you to display basic configuration data for the engine and ECM. The Engine
Configuration Datawindow is also displayed automatically if the PC is connected to an ECM when you
click on “Close” in the Welcome screen.

1. Choose “Engine Configuration Data” from the Diagnostics menu to display the Engine Configuration
Data window:

Engine Configuration Data |

ECM data |

Engine Sernies: ISEIiES BO11.1L

Engine zeral number: IDEHEDD'I (I5i3] Rated BHF: 365

WIN: [CX475-4FD 03365074 Feak Torque it |—1 50
Engine maodel: IEUE?W'KEU Rated engine RFM: I'I 810
Idle speed RPM: |5?5 Peak. torque BPM: I'I 200

LSG dioop RPM:  [125

Print | Close |

2. Click on the ECM data tab to view configuration information for the ECM (or ECMs in a multi-ECM
engine).

Engine Configuration Data E4 |

Master ECM R1ECH R2ECH
R ating group [(BM 4k 8]: IEI IU IEI
Rating family (EN4D#: |0 B o
Application tamily (GM4CH]: IU IEI ||:|
EP& Certfication: |544 B E
ECM serial number: |b1000010 ECH Mot Present  |ECH Nt Present
ECH software level: IF".'IDD IEEM Mat Present IEEM Mot Present
Shared version IU IEI IEI
R ating version I? IEEM Mot Prezent IEEM Mot Present
Print | Close

1. Click your mouse on “Close” to close the Engine Configuration Data window.
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The MBE Engine Configuration Window

The MBE window operates in the same manner as the DDEC window. It displays basic configuration data
for the engine and ECM as shown below. Thereisonly one tab of information displayed on the MBE
window. The Engine Configuration Data window is also displayed automatically if the PC is connected to
an ECM when you click on “Close” in the Welcome screen.

MBE Engine Configuration Data

VO _PLD Properties |

E ngine Sernes KEE 4000 [E]

Engine Serial Ha |4EEIE|EIE 00 743000

E nigine kodel |4EEI

WM IDDDDDDDDDDDDDDDDD
EFA Certification I4EDL.&_98.3_435£1 550

& Code WL I.-’-‘-. 000 445 30 35
FLD I.-“-‘-. 030943 36 44

Software Wersion WL |1 214
FLD hEE
Diagnosis Yersion WL 151
FLD B
Print | Close |
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ECM I/O CONFIGURATION (DDEC IIl, IV, & V)

TheDDEC II1 and IV Window
To examine the status of switches, the ECM input and output function configuration, or to set the output

function values temporarily for testing, follow this procedure.

1.

Choose “ECM 1/0O Configuration” from the Diagnostics menu to display the ECM 1/O Configuration
dialog box. (For multi-ECM engines, the input and output function configuration of each ECM is
shown on a separate page.)

ECH 1/0 Configuration E

Master ECM | R1 ECM | RZECM |

— Input funchions — Output functions
J1 [SET/COAST OM [Dpen F3 WEH PWR DOWN [Gind
F1 Al FAN CHNTL [Dpen &2 [FAM CNTRLHT [Dpen
G2 |RES/ACCEL OM [Dpen 53 [ENG BRK MED [Dpen
F2 [CRUZ ENAELE [Dpen T3 ENG BRK LOW [Dpen
J2 [CLUTCH REL [Dpen W3 MOME |
G2 [SERW BRE REL [Dpen #3 MNOME |
G1 SE0/DIAG REQ [Open 3 MOME |
E1 [FAN OVERRIDE [Dpen &1 [CODL LOw LT [Dpen
H1 [ExT FROTECTA [Dpen .
H2 [P&RK BRKASD Dpen -T;.fm.gm — %gnd
K2 ENG BRK MED Dpen " — ;g ;
K3 [ENG BRK LOW Open NONE =an
W2 NONE | Zgnd
%
— Timed Input function #2 NONE | Zand
#1 [NOME
Sawve Print

Test an input by changing the position of the switch. When a vehicle switch has been activated or
turned off (for example, the parking brake switch), the status of the associated input will change.

To set an output function temporarily for testing, click on “ Activate Outputs’ to display the Activate
output dialog box.

Beginning with DDDL 4.1, auser may save the current ECM 1/O configuration as atext file. Click
once on the “ Save” button and you'll receive confirmation that the information was saved to atext file

with the name of the engine serial number.

DDDL E

& |/0 Canfiquration Saved to C:\Detrait DieselhDiagnoshich O CanfighO6R 02007 77 txt
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REMINDER: THIS FEATURE DOES OPERATE WITH A DDEC II ECM

The DDEC V I/O Window
One of the biggest changes to the DDEC V ECM is the number of digital inputs and outputs have greatly
increased. Thel/O screen for DDEC V has been changed to accommodate the increased values:

DDECYV INPUT SCREEN

x
DDECY Input | DDECY Duput |
Ch I Marne I Function Manme I :I
36 EGR -
kr REF_2vhH Analog A0C Reference
a8 EGE -
33 ER Enagine Coolant Temp
40 E23 -
41 EQ Fuel Temp
42 INJ_WREG Function Mot Found
43 E2 Air Inlet Temp
44 CS_E1 EGR Walve Current Signal
45 E22 Turbocharger Compreszor Qut Temp
46 E7 Engine Oil Temp
47 E10 EGR Temp
43 WE1 Battery voltage
43 BARLFP_BATT RTC Battery
A0 E12_EZ2B Enagine Senzor Supply
a1 W11 W12 Yehicle Senzor Supply
A2 INJ_WSLOPE Function Mot Found
53 IMJ_IPULLIM Function Mot Found
R4 F27 - LI
l Counts I— State
Print | Save Close
DDECV OUTPUT SCREEN
X
DDECY Input  DDECV Output |
Ch | I ame | Function Mame | Achieved | Intended Iil
7 Wh5 - -
g Whe
9 Wh3
10 E13 - - -
11 E4E Switched B attem (]| (]
12 E47 - - -
13 E43 Engine Brake Med (u]§] OFF
14 E43 Engine Brake Low M OFF
15 ERD - - -
16 ES1 Switched B attery (]| (]}
17 ERZ - - -
18 ER3
19 Frahd W52 - -
20 Fu'dd_\ 46 Fan Clutch Contral 9
21 Phd_E1 - -
22 Fibd_E4
23 Feihd_EB
24 b _E11 =
Activate Dutput [ER 16 EB1 : Switched Battery OM -] set |

Print

| Save

OFF
ml‘ﬂlusa
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Aswith other
versions of
DDEC the
inputs are
listed for
informational
purposes only
and may not
be changed
with DDDL.
This
information
may be
printed or
saved to a
text file by
selecting the
appropriate
boxesin the
lower portion
of the screen.

The outputs
settings may
also be saved to
atext fileor
printed by
selecting the
appropriate
boxesin the
lower portion of
the screen.
Highlighting the
output in the
list, selecting
the state you
wish to place
the output in,
and then
selecting the
“set” box may
activate outputs.



VIEWING INJECTOR RESPONSE TIMES (DDEC ONLY)

Y ou can use DDDL to view the fuel injector response times. Choose “Injector Response Times’ from the
Diagnostics menu to display the Injector Response Times dialog box.

Injector Response Times

Cylinder #1

Cylinder #2

Cylinder #3

Cylinder #4

Cylinder #5

Cylinder #6

112

1.09

117

1.11

113

1.19

0]:4

Print

The cylinders for the other ECMsin multi-ECM engines will be shown below the master ECM cylinders.
When viewing cylinder numbersin engineswith "V" configurations, the side of the engine the cylinder is
located on will be designated as either Left or Right (such as cylinder 2R) or as A or B cylinder (such as

cylinder 2A). For more information on cylinder numbering and identification, please refer to the specific

engine service manual.

THE MAINTENANCE ALERT SCREEN (DDEC ONLY)

Thefinal selection in the Diagnostics drop-down menu istitled “ Maintenance Alert.” When you make this
selection the following screen appears:

Maintenance Alert E

il Lewvel

Coolant Level

Air Filter R estriction

Oil Filter R estriction

Fuel Inlet Restriction

Preventative Maintenance Status

I8

S ervioe £ INot Canfigured
T INot Canfigured
o INat Configured

[Elean Mantenance bades |

Prirt
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This screen displays information on two distinct items:;

It displays the status of the sensors in the Detroit
Diesd Maintenance Alert System (MAS). MAS
is an optional feature consisting of a set of sensors
and a cab-mounted display unit. Thisdisplay
alows you to view the status of the parameters
MAS monitors and to reset the cab display if
maintenance has been performed on these
parameters.

Y ou can monitor the status of three Preventative
Maintenance (PM) items that can be set up
through DDEC Reports. For more information on
setting up the PM feature see DDEC Reports Help.



VIEW OBSERVED MIDS (DDEC AND MBE FEATURE)

Beginning with version 4.1 you may view alist of al the Mids (Message |dentifiers) that have been
observed communicating on the link since the connection was last made. Choose View Observed Mids
from the Diagnostics menu to display the Observed Mid List dialog box:

Observed Mid List

MID | Tupe |
128 Engine Contral Unit, b aster

Press OK to close the dialog box and return to the main window.

EXHAUST BACKPRESSURE FAULT TIMES (DDEC Only)

Exhaust Backpressure Fault Times E| Beginning with version 4.20 you may view
the exhaust backpressure fault times on DDC
Tirme vihile Series 2000 and 4000 series engines that
support thisfeature. Choose Exhaust
SCALED HIGH fault active :00:00 Backpressure Fault Times from the

Diagnostics menu.

RaMPDOWM fault active :00;00 )
NOTE: The Min and Max values for exhaust
back pressure PID 81, FMI 0 (code77) reset
when theignition is cycled. The Pro-Link
reader retains the maximum value seen.

CLEAR THE AFR LEARN TABLE (DDEC Only)

Theair /fud ratio table is component on DDC natural gas engines only. To clear the table, go to the Tools
menu and select the Clear AFR Learn Table option. When the operation has been performed you will
receive this message:

DDDL [X]

' "_a The AFR Learn Table has been successfully ceared.
L

4
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The Particulate Filter “De-greening” Process

Certain transit bus calibrations work with particulate filtersin order to meet emission standards. When a
new particulate filter isinstalled part of the set up process involves running the “de-greening” option now
availablein DDDL 6.2.

When anew particulate trap filter is installed, the exhaust backpressure limit triggers a PID 81 indicating
excessive exhaust backpressure. This increased threshold is applied for the first 4000 vehicle miles after the
filter isinstalled.

If thisfault code is not addressed within 50 hours after installation by running the de-greening option, the
SEL will illuminate and register aSID151 FMI 11, which isa " Service Now Lamp Fault Expired" code.
PID 81 will re-occur each time the key is cycled unless the de-greening process has been started.

To run the de-greening processin DDDL.:

ti: Detroit Diesel Diagnostic Link

File Calibration Snapshot Disgnostics

[6i5] 7]2]0] o[s]  Fereon
DDEC Reports

Particulate Fiber De-green Reset

1. From the tools drop-down menu choose the “ Particul ate Filter De-green Reset”

2. A message will appear in the center of the DDDL screen asking the user to confirm that the process
should be initiated.

1 E The Particular Fiker De-green has been reset.

[ o 1

3. The user will receive a message confirming that the process has been completed.
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Engine/Trip Data

TrioValues Engine Totals |

Accumulated Tote ——
Fuﬂds Iun
Howes |un
riles I

Fevse 0
[ 1000

Cnaz=

4. The user may review how many miles the engine has run since the last de-green process was compl eted
by choosing the “Engine/ Trip Data” option form the “Tools” drop-down menu. The information is
contained on the “Engine Totals’ tab in the lower right corner.

Recalibrate NG Oxygen Sensor

Users of DDDL 6.2 that have natural gas engines may now manually recalibrate the oxygen sensor. To use
this function please follow these steps:

File Calbration Snapshot Diagnostics | Tooks ‘Window Help

||| ™2 0| @|m| Eoone/TripData
DDEC Reports

Clear 4FR. Learn Table

Particulate Filker De-green Reset

I. Gotothe“Tools’ drop-down menu and choose the “ Recalibrate NG Oxygen Sensor” item. Thisitem
will only be available for use with DDEC natural gas engine and will appeared “grayed out” in other
DDEC application,
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I1. A message will appear with instructions for preparing the sensor to be recalibrated. Once thisis done
simply click on the “OK” box to recalibrate the sensor.

Oxygen Sensor Recalibration x|

For proper recalibration, the sensor
must be removed from the stack
and placed in "clean air'. Select
"0K" to recalibrate the sensor,

oK I Cancel

[11. If the operation is successful you'll get a message back acknowledging that the operation is complete.

pooL . §

i’ ! 5 Sensor Recalibration Complete

oK

If there was a problem with the operation a message will appear informing the user that the operation was
not successful and giving the user possibilities as to why the operation was not successful. For further
information on successfully completing this operation please call Detroit Diesel Technica Service.

x
& 02 Sensor Recalibration Failed. This is mast ikely due to one of the following reasons:

13 02 sensor not configured on Analog channs!
2) Engine running

3) Sensor Faulk for O2 sensor

4) Ignition OFF

S Recal day is 0in calibration.,

8] 4




MBE Progressive Shift Calculator

Progressive Shift encourages drivers to upshift from a lower to a higher gear prior to reaching the
engine’s governed speed. The low range threshold of operation is defined by a Gear Ratio
(parameter 12307). The maximum engine speed will be limited to a maximum progressive
shifting engine speed (parameter 12306) when the transmission is a ratio less then the Gear
Ratio. The engine will be allowed to run up to maximum rated engine speed when the
transmission is in a ratio greater or equal to the Gear Ratio.

Formula ** Gear Ratio = Transmission Output Shaft Speed (rpm)/Engine Speed (rpm)
Gear Ratio = Transmission Output Shaft Speed (rpm)/Engine Speed (rpm)

To display this screen, select Tools and Progressive Shift Calculator.

i Detroit Diesel Diagnostic Link
File ibration Snapshot  Diagnostics BELER window  Help

= =zle| @ EnginefTrip Data

DDEC Reports

Opkions,

The following will help you calculate and enter your gear ratio value via DDDL.

A) Select the gear you wish to limit the rpm up through and the next gear up from this. Example
9" and 10" gears.
B) Identify the ratios for each gear and enter these numbers in Ratio A and Ratio B respectively.

Calculate MBE Progressive Shift Gear Ratio

Ratio Fiesult Current 12307
R atio &
(Eom ] [1.34 | 0.673
R atio B 4
[Gear H+1] 0
Calculate | Clear ¥ alues | Cancel

C) Retrieve the calibration in DDDL.

D) When both values are entered, the Calculate button will highlight.

E) Select Calculate to see the result.

F) The “Paste to 12307” button is enabled allowing the user to directly paste the value into field
12307 (Gear Ratio for Progressive Shift). If the calibration is not loaded. A message
indicating that the calibration must be loaded to paste is displayed.

G) Verify that the Gear Ratio field has been populated with this value.

10-Speed Manual
Torgue
Tramsmission Modal Rating | Overall |Rov. | Rev.
Description Number Ih-ft Ratio L H Ratio and Percent Step
FWD.| REV. 1 % 2 % 3 % 4 % & % & % 7 % B % 6 o 10
10-Spead Direct Drive, | M-116104A-M11 1,150
A Ratio M-12610A-M12 1,250
M-13610A-M13 1.350 [ 95.0p| 1871 (1871|272 [15.02 35 11.14 35 9.26 37 6.02 34 449 4 235 35 248 35 104 37( 1.2 $4 1.00
M-14B10A-M14 1,450
M-15610A-M15 1,550
M-14610A-M161 | 1450

oth gear = 1.34 ** 10" gear = 1.00

A

55



Step 1:
Select the gear you wish to limit the rpm up through and the next gear up from this; example o
and 10" gears. ldentify the ratios for each gear.

Step 2:

Invert each gear ratio by dividing 1. In this example, the inverted ratio for o gear will be .75 and
10™ gear will be 1.00.

Step 3
Select a number between the two inverted gear ratios. We'll select .87 and this will be our gear

ratio for progressive shift (parameter 12307). Enter this ratio into parameter identifier 12307. The
follow is a screen shot of the VCU parameter field in DDDL.

B Datroil Dissel Diagnostic Lisk - [14mw_mbe COF |

O fle Cabestin gaapshot Qagroshce Jook Wiedow b

ECIE) o|=| 7| A «|[[NSCodEST][ Offine ]
Parsmeter List 71 |
@ | Index | Mame Valug Unit Min | Max
« @ VE Group 21 - Droop Control Made
=& NCU Group 23 - Limiters 11
]
D
]
D
]
D3 12306 Max engine speed far pragressnve shifing 180 mm 00 oo
[ 12307 Gear Fistia for Progressive Shiting = = mehtpm 0000 1243
D
b

Engine / Trip Data Options

To access basic engine trip information with DDDL, go to the Tools drop-down menu and select the
“Engine/ Trip Data’ option. A screen with two tabswill appear. Thefirst tab contains the current stored
trip data values, while the second tab contains the totals for the life of the engine.

Engine/Trip Data

—Accumulated Tatal—— VSG——————————— Optimized ldie

The export feature may be
used in DDDL 5.0 or later
on MBE VCU modules

Fuel 7301
0.2
oals Hous | Haus | with software level 12.09

Hours |193_4 Fuel Im— Fusl or higher. Y ou may not
filles |1 2433 gals 1 gals reset the trip data with this
feature on MBE engines.
ldle———————— [ Chizse "Engine Brake Trip datamay only be reset

Hours |181-3 Hors |D.D Hours ID.1 by performing an
extraction with DDEC

Fuel I =, i}

L:als ee0 “ I Reports.

= |94

Export | Print Close

Exporting the engine/trip totalsin versionsprior to DDDL 3.1:

1. Press“Export” in the Engine/Trip Data dialog box. Y ou may export datafrom all DDEC ECMs. |f
you are using aversion of DDDL prior to 3.1 the current trip could only be cleared on aDDEC |1 or 111
equipped vehicle. After the data has been exported, you will be asked if you want to reset the trip.

DDDL

Esport successful, Reset tip data [v/M]?




Exporting the engine/trip totalsin versions DDDL 3.1 and later (DDEC Only):

1. With versionsof DDDL 3.1 or later, the Export option remains the same for DDEC |1 and I11. In
addition, you have the option to reset DDEC IV / V trip data after a successful export. When you choose to
export DDEC IV trip data you will see the following message:

DDDL

FLEASE READ BEFORE RESETTING
YOURDDEC v TRIF DATA:

Ifwau choase the reset option, all of the current DDEC
Data trip walues will return to zero and be unavailahle
far extraction.

Export successful, Resettrip data (viM)?

2. If the Vehicle Unit Number in the ECM is blank, or you have DDEC |1 or |11 ECM software earlier
than version 4, you will be asked to enter the Vehicle Unit Number. In DDEC |11 the Vehicle Unit
Number is separate from the VVehicle Identifier. (The latter can be set and viewed in Detroit Diesel
Communications.) However, the Unit Number and Identifier are the samein DDEC 1V /V. For a
complete discussion of the datafile created by the export function, read “Understanding CSV Files.”

UNDERSTANDING CSV FILES

Where doesthe data | export in DDDL go?

Exported datais sent to afile with a.csv extension.

What do these files contain and how can | look at them?

CsV filesare simply files that contain engine trip data that can be loaded into commonly used spreadsheet
programs. Consult the help section for the spreadsheet program you are using for opening CSV files.

Where arethese data files located?

The CSV filesDDDL creates are found in the C:\Detroit Diesel\Diagnostic\Report directory. There are
four filesin this directory when the program is first loaded.

1. _exp_dp.csv

2. _exp_acc.csv

3. exp_dp.csv

4. exp_acc.csv

What information isin each of these files?

1. Thefileswiththe“ " inthefront of the name are templates for how the columns of data are setup and
never contain any data. Do not open thesefiles.

2. When you choose to export data from the Engine/Trip data section of DDDL, the information is
transferred to anew row in the exp_acc.csv file. Every time a new export occurs a new row of
information is added to the exp_acc.csv file.

3. Dataisadded to the exp_dp.csv file every time a DDEC Reports extraction is made. Essentially the
same data that appears in the trip activity report in DDEC Reportsis placed in a new row of the
spreadsheet. The next time an extraction occurs another line of dataisadded. Every timeaDDEC
Reports extraction is successfully completed an .xtr file is made and arow is added to exp_dp.csv.
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What isthe main purpose of the CSV files?

Information gathered on the entire fleet can be summarized and analyzed using all the capabilities of your
spreadsheet program.

Arethereany other special featuresregarding CSV file?

1.

At the end of a calendar month the CSV files are automatically renamed and stored in the same
directory. This process occurs when you complete the first export or extraction in the next calendar
month. The exp_acc.csv and exp_dp.csv are cleared and begin to collect data for the new month.
These CSV files are useful for fleets that wish to summarize vehicle activities.

Do not savetheoriginal CSV filewhen it isopened up in the spreadsheet. If you do, you will ater
the dating mechanism that detects the end of the month. 1f you wish to save your spreadsheet
information, use the “Save as’ selection and save the file under another name. Leave the original CSV
fileaone. Savingthe original CSV file within the spreadsheet causes problems with the automated
features of the CSV file.

An important utility for creating CSV datafiles from .xtr and .dhp filesis available in DDEC Reports
3.1or later. For detailed information on this feature see the "CSV Creation Utility" section in this
guide.

The dataformat of CSV filesis English units only, regardless of the DDDL’s unit settings.

CONFIGURING DDDL TO PRINT OFF-LINE

Setting up your Printer

Setup your printer to work offline by clicking on “ Start,” selecting “ Settings,” and selecting
“Control Panel.”

Select “Printers.”
Highlight your desired printer.

In the File menu, place a check by “Work Offline” by selecting it with your mouse. (Some
computers may not have the “Work Off-line” option. “Pause Printer” can be selected and
will perform the same function.)

B3 Printers =] E3
File Edit “iew Help

—

Add Printer  Microsoft Fas

| 1 object|z] zelected o
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In the example below we will send the engine configuration data to the printer to be stored and
printed at alater time. The process will work with any DDDL screen that displays the option to
print.

Saving Data to the Print Queue.
1. Connect your PC through atranslator box and cables to the diagnostic connector of atruck.
2. Start the Detroit Diesel Diagnostic Link software.

3. The Welcome screen shown below will be displayed.

Welcome to Detroit Diesel Diagnostic Link

Whatwuuld wou like to do? A CAUTION:

D | create a new calibration file

&  To avoid personal injuty, the operator of
a DDEC-eoquipped vehicle moast not use
ot tead this diagnostic tool while the
vehicle iz it operation.

*  Doing so may result in loss of wehicle
control, which may cause vehicle
datmage and may result in personal

loak atthe instrumentation values jury.

&  This diagnostic tool roast be used by
personniel other than the wehicle

look at active and inactive faults operator.

&  The vehicle operator st maititain
control of the vehicle while an assistant
petfiorims the diagnostic evaluations.

open an existing calibration file

retrieve the calibration frarm the EChd

stad recording a snapshot

Close Cluit

4. Closethe Welcome screen.

5. The Engine Configuration screen will be displayed.

Engine Configuration Data
l ECH data ]
Engine Series: |Series B0 11.1L
Engine serial number: |EIEF|EEIEI'I 085 E ated EHP: |355
WIN: |C475 AFDOSIES0/A Peak Torque ftlbr  [1350
Engine model: |E':'E'_""*"‘-”(~'3':I Rated engine RFH: |1 510
Idle speed RPH: |5?5 Peak torgue RPH: |'| 200
LSG doop APM:  [125

Print Close




6. Choose“Print.”

7. The Print screen will be displayed.

Pt _____HEH|
— Printer
Mame: HF Lazerlet 45i [Copy 4] Bropertiez |
Statuz: Default printer; Beady
Tupe: HF Lazerlet 45i
WWhere: SWWE dsnt] heeus 1
Comment: ™ Print to file
— Print range — Copies
= Al Humber of copies: 1 -
© Pages  fram: |1 ko
foml1 | te] L] e
£ SElEctinn
k. Cancel

8. Choose“OK" to save the Engine Configuration to the Print Queue.

Print the Stored Data

9. When you have saved al the Engine Configuration screens you wanted to, go into the
Control Panel and disable the “Work Off-ling” or “Pause Printing” option. The next time you
turn on your computer, you will be prompted to print.

10. When ready to print, connect your printer to the PC before you turn it on.
11. Print the Data.

Printers Folder |

HF Lazerlet 45i [Copy 4] printer haz 2 job(z).
To ztart printing theze jobs, click Yes. To pausze printing,
click Mo, To delete these jobs, click Cancel.

Ha Cancel

Note: You may use the same procedureto print any DDDL data screen offering the
print option.
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DROP-DOWN MENUS IN DDEC REPORTS 6.3 (DDEC & MBE)

File Connect
Open Communications Manager
Print Setup Vehicle After Extraction
Print Preview
Print Setup
Print All

Exit

View Tools
Activity > Diagnostic Link
Speed/RPM > e
Load/RPM > Extraction Log
Over Speed/Over Rev Vehicle Registry
Vehicle Configuration Vehicle Parameters
Periodic Maintenance Options
DDEC Diagnostic Records
Hard Brake Incidents > Archive Extraction Files
Last Stop Record > Export Datato CSV
Profile
Daily EngineUsage > Select Application
Life-to-Date

Help
Help Topics
About DDEC Reports...

VIEWING DATA FROM COMPLETED EXTRACTIONS

In order to view the various reports available in DDEC Reports, you must open afile from a successful
extraction. A trip or period activity report will automatically appear on your screen after a successful
extraction or you may open a previously extracted set of data by going to the File drop-down menu and
selecting the "Open" option.

Once theinitial report is displayed, you may view any of the other reports by accessing the “View” drop-
down menu and choosing the type of report from the list displayed. An arrow next to the name of the
report in the menu indicates there is more than one way to display the data. For example, a Hard Braking
incident can be displayed as atable of numbers or asagraph. If anitemin the View menu is"grayed out,”
it means there is no data available in this extracted file to create areport for thisitem. The reports available
will vary from vehicle to vehicle depending on the software level, options selected in the calibration, and
the version of DDDL with which it was extracted.

Selecting “Print” from the file drop down menu may print any report displayed on the screen. Beginning
with DDEC Reports 4.1 thereis an additional option to print all the reports available in that file.
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HOW TO EXTRACT TRIP DATA FROM A VEHICLE AND CREATE
REPORTS

INITIALLY SETTING UP COMMUNICATIONS MANAGER

Before you begin your first extraction, follow these steps to set the Communications Manager to pop-up
and allow you to view the progress bar during the extraction. Y ou can perform these steps from either the
DDDL or DDEC Reports program.

Go to the Tools drop-down menu.

Select the “Options” item.

Select the * Communications Manager” tab.

Change the option in Windows Pop-up Preference from “Never” to “On Extraction.”
Click on the “OK” box at the bottom of the dialog box.

Exit the program. When you re-start DDEC Reports you will be ready to begin.

ok wnNpE

Important Note: The vehicle must contain a Detroit Diesel engine withaDDEC ECM or an MBE engine
with aVCU module with 12.09 or later software. A DDEC |11 ECM must be Release 5.0 or higher and
Data Pages must be turned on. All DDEC IV and V ECMs can be extracted but some data is not available
in DDEC IV modules with Release 20. MBE extractions may be performed with DDEC Reports version
4.1 or later.

THE EXTRACTION PROCESS

1. Plug the Detroit Diesel trandlator box cable into the vehicle 6-pin or 9-pin diagnostic connector. Connect
the cable from your computer to the translator box.

2. Starting from the main Windows desktop screen use your mouse and left click once each on the
following items; Start, Programs, Detroit Diesel, and finally DDEC Reports

3. Thiswill bring up the DDEC Reports program. When the program first opens you will see the drop-
down menus, the icon toolbar, and a blank white screen below (for versions 3.0 and earlier) or a start menu
screen (for versions 3.1 or later). Close the start menu if you have one. You'll notice ablank gray box
under the File drop-down menu in the icon bar. Thisicon isidentified as the Communications Manager.

4. Turn the vehicleignition on. A small tri-colored light will appear in the previously grayed out
Communications Manager icon box within 15 seconds.

5. With your mouse, |€eft click once on the Communications Manager icon at the left end of the tool bar.
Thiswill initiate the extraction process. Y ou will see a message on the screen: “ Communicating with
vehicle, please wait.”

6. If thisisthe first time the vehicle has been connected to the computer you are using, an Unknown
Vehicle ID box will open (usualy in 30 seconds or less). Type the vehicle ID into the Add/Assign Vehicle
ID dialog box and click “OK.”

7. You will see ablinking amber light in the traffic light status box indicating that data communication is
taking place. Status barsin the window will show progress for the devices being extracted.

8. The traffic light will turn green in afew minutes and adialog box will appear (in versions 3.1 and
earlier) stating that the extraction was successful. Click “OK”. Inversion 4.1 or later the activity report
appears automatically.

9. The Trip Activity report will appear on the screen automatically. Y ou may choose other reports by
clicking on the various report icons on the tool bar or by selecting from the View menu. The View menu
contains some report options not represented by icons on the tool bar.

If you experience any problems with extractions you may wish to review the material in the DDDL CD
covering common extraction problems or call the DDC Helpdesk for assistance.
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OPTIONS FOR CLEARING TRIP DATA IN DDEC REPORTS 4.1 &
LATER (for both DDEC & MBE Systems)

Whenever you complete a successful extraction of trip datain DDEC Reports, the default settingsin
the program reset thetrip dataregisters. However, there are cases when you may wish to extract the
information from a vehicle and not reset the trip data. Follow these stepsin DDDL version 4.1 to set up a
single vehicle so that trip data does not get cleared:

1. Open up DDEC Reports and go to the “ Tools’ drop-down menu.

2. Fromthe “Tools’ menu, select “Vehicle Registry.”

| Untitled - DDEC Reports
File Connect “iew JEKalalE

Help

N3 =] | Deonestelbink 12 N2 N 2 N R R

Estraction Log

Yehicle Beagistiy
Yehicle Parameters

Optionz

Archive Extraction Files
Export Data ko C5Y

Select Application

3. The Vehicle Registry Editor will appear on your screen. If you have aready extracted data from this
vehicle before, double click with you left mouse button on the vehicle you wish to modify in the “vehicle
ID” column and you'll be taken to the “Vehicle Details’ screen (move directly to step 5). If you have never
extracted data from the vehicle before, you' Il need to set up the vehicle in the vehicle registry. Click on the
truck / plus sign icon and you' I be prompted to enter the vehicle ID.

E Vehicle Registry Editor

File Edit “iew Toaolz Help

3| | &z wlE#E] 2

Yehicle ID | Devices | Time LastS_ | Site Last .. | Time Last Ex... | Site Last ... | Time Last Se___
DEFAULT DHLP
111 D 128/ 110 J 12811 J
Wehicle ID: |
Engine Senial #:
[ phional]
(]9 I Cancel

Enter the ID. (If you want to check for an existing Vehicle ID, you can retrieve the calibration in DDDL
and check the “Vehicle Unit Number” on tab 1 prior to beginning this process.) Click on “OK”.
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4. You will see a screen asking you to identify the devices you will be extracting from on this vehicle.
Typically thiswill beaDDEC ECM. If you are setting up a unit with an MBE engine you should also
select the DDEC option. When you havefilled in the correct device(s) click on “OK” in the “Add Device”
box. The Vehicle Details screen for the vehicle you have just set up will appear.

Yehicle Details x|

Add Device

™ Logger
™ EroDriver
™ Highweaybd aster

oo

Cancel Add Device | Delete Device Eestore Help

5. The“Local Extractions’ section located in the lower |eft of the Vehicle Details screen contains the
options for customizing the data to be extracted. When the screen initially appears these options appear to
be “grayed out” or inoperative. To enable choices among the options, click once with the left mouse button
on the “Edit” box in the upper right side of the screen. (Those familiar with earlier versions of DDEC
Reports will notice the “Vehicle Details’ screen has been re-designed in version 4.1.)

Yehicle Details - Yehicle ID 5678 |

Local Extractions
(Desired Setup File; IN.:.ne

[

Edif I

Apply

DDEC I'v |

Note on the Vehicle
Details Screen for
MBE users.
Thedetailsfor
MBE unitsin the

Dievice Status; INE'W' Software Yerzion: |2'| .00 vehicleregistry will
Time Lazt Extracted: INf'.-'i'x Site Last Extracted: I ﬁfbpe% %ngg(e:tf\t/)
Time Last Seen: IN;".-’-‘-. Site Last Seen: I The software

, _ : _ version will display
Time Setup Lazst Loaded: IN;".-’-‘-. Site Last Setup: I the correct
Last Setup File Loaded: I Engine Serial #: I softwar e version of

the VCU module

extraction has been
made from that

Local Estractions Eemote Exfractions after thefirst
¥ Ertract From Thiz Device I¥ | Eviract Erom This Device
o Tiip [~ Reset &l Data & Tiip
 Trip With Incidents ¥ Feset Trip £ Tirim itk neidents I™ | Heset Tiip unit.
" Profile ¥ Reset Clock %] Erafile
(] | Cancel | Add Device | Delete Device HEstore Help |

Y ou may now disable the reset action on this vehicle by removing the check from “Reset Trip” box. (For
more detailed information on all the choices available concerning data extraction see the Detroit Diesel
Communications Help.) When you'’ ve finished making your selections, click once with the left mouse
button on “Apply” in the upper right of the window, and then select “ OK” with the left mouse button. For
details on setting up trip clearing options on versions of DDDL 3.11 or earlier, see the Documents section
of your current DDDL CD.
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DDEC REPORTS INFORMATION AND TIPS

1. CAUSESOF FAILED EXTRACTIONS

If you failed to successfully extract your data, please review the information below:

A. Extraction fails due to no Dataset Definition File (DDF file). For versions prior to 4.10.

If extractionsfail repeatedly on a particular vehicle, go to the Tools drop-down menu and select the
“Extraction Log Viewer.” If the extraction record in the viewer indicates that the extraction failed dueto a
“bad data set,” close the Viewer and go to the Tools menu once again. Click on the “Vehicle Registry
Editor” to open it. Select the truck you are working with and double click the mouse pointer on that unit.
You will seethe Vehicle Details Screen. Check the “ Dataset Definition File” title shown in the
corresponding box. If “none” isdisplayed, click on the down arrow at the right side of the box and change
to a selection with the word "trip" in the title. Now retry the extraction.

B. Trip activity report with zeros

If you have afailed extraction from a vehicle followed by a successful one, the trip activity
report that pops up will show all zeros. However there is good information available to display
if you know where to look:

- The monthly portion of the trip activity reports has three months of datato view.

- The daily engine usage report has the last 30 days of data available to view.

- The configuration page has complete data.

- Thelife to date page is aso complete.

C. Mistaken use of the Profile extraction

When making extractions with the trandator box or the RDI, use DDF files with the word "trip"
inthetitle. The Profile extraction isa small subset of atrip extraction and is meant for wireless
extractions only. The Reset DDF fileresets all ECM data without extracting afile.

D. Inadvertent extraction abort

In versions prior to DDDL 3.0, you may inadvertently abort an extraction if you hit the “Enter” key after
you have entered the vehicle ID instead of clicking on “OK” with your mouse.

E. Activating the communications manager the wrong way

Only click on the small traffic light icon in the toolbar (along the top of the screen) to initiate the
extraction process. Be very careful to click on theicon only once. Don’t click on theiconin
the tray on the taskbar (bottom of the screen).

2. MISSING OR DUPLICATE DAYSIN REPORTS

If days are missing or duplicated in the daily engine usage report, there is probably a conflict between the
fleet time zone set in the ECM and the PC time zone that processed the file. There are actually no days or
data missing or duplicated. The report disparity can be corrected by setting the time zone of the reporting
PC to the fleet time zone. Fleet time zone can be found in the Configuration Report. The time zone can be
set in DDDL.
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3. INFORMATION ON USING DDEC REPORTSTO OBTAIN MBE ENGINE DATA

The ability to gather fleet management information, similar to DDEC Data has been added to engines
equipped with MBE electronics VCU modules programmed software version 12.09 or higher. This
information may be extracted and reports made with DDEC Reports 4.1or higher. Here are some things to
remember about 12.09 data extractions:

1. Theinitial date stamp for the first extraction you perform will probably show the year 2027. This
condition is similar to the first extraction from DDEC |11 Data Pages showing a 1985 date. The updating of
the clock at the time of the extraction will correct thisissue.

2. Thefirst extraction after an upgrade may also contain corrupted data. This would be due to not having
gathered information correctly with earlier versions of software. Once again this condition will be corrected
after the initia trip datais reset.

3. DDEC Reports 4.1 or later is the only software that currently can extract data and create reports. At the
current time Data Summaries does not work with the MBE data.

4, Extractions of MBE datawill produce an X TR file with the same naming conventions and default
location as a DDEC IV extraction.

5. The setting for top gear —1 is not being currently set at the factory. The parameter (11608 in VCU 12
software) may be set with the Minidiag, Pro-Link card for the MBE, and DDDL.
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AN OVERVIEW OF DATA EXTRACTION FILE TYPES

There are severa devices within the Detroit Diesel product line that collect trip datafor extraction. The
datayou extract is automatically saved with afile name that indicates which device collected the trip data.
Different file types are stored in different folders. Here is an expanded view from Windows Explorer
showing the folder structure where extracted trip data files are stored.

=-{_7] Detroit Dieszel

EH:l Ciagnoztic
& Data Pages

DDEC IV, DDEC V, and ProDriver 3.0 Files (.xtr)

Trip datafrom DDEC IV/V and from ProDriver 3.0 is automatically saved in files with the extension .xtr.
The xtr files are stored in the Data Pages folder (C:\Detroit Diesel\Diagnostic\Data Pages). If both DDEC
IV and ProDriver 3.0 are installed on the same vehicle, the datais saved in the same .xtr file. If only
ProDriver 3.0 isinstalled on the vehicle, use ProDriver Reports 1.0 for data analysis and reporting.

| Contents of 'Data Pages'

Mame
1 Invalid
] 0_miles.dhp
=] 02067-ab.dhp
&) 04176gaa.dhp
] 041 76qad.dhp
=] 04156gaa.dhp
=] 04186gae.dhp
] 04196qab.dhp
] 04196qad.dhp
8] 051271 ap. xtr
] 06207 dae. xtr
8] 0701 Prnai.str
@ 0707 Fmarmn. =tr
EI 0701 Frnao. str
8] 07027 mab. xtr
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Filesfor Exporting to a Spreadsheet (.csv)

Extracted DDEC datais also automatically saved in .csv files that can be exported to a spreadsheet. The
.csv files contain all the extracted files for the current month. At the end of the month, the current month
files are closed and renamed for archiving. The .csv files are stored in the Report folder: C:\Detroit
Diesel\Diagnostic\Report.

Thefiles_exp_acc.csv and _exp_dp.csv contain infor mation used in for matting the spreadsheet. Do
not open thefilesthat begin with the underscore character (_).

| Contents of 'Heport’

Mame I Size I Type

M| _ewp_acc.cav 1B CSY File
S _exp_dp.cav 2KB S5V File
EJJ E¥p_ACC.oTv 1B C5% File
) exp_dp.osv BKE CSY File
E PaS70700 cav kB CSY File
E PoS7080:. cav 7akE  CSW File

There are two export files for the current month: exp_acc.csv and exp_dp.csv. (Note: Thereisno initial
underscore in the file name.) The two files contain different information, so both files can be exported
when doing spreadsheet analysis. The .csv files are comma separated valuefiles.

The two files starting with Po are archived datafiles. The file name is written as:
PoYY MM DD . csv

YY isthelast two digits of the year
MM isthe month expressed as a number
DD isthe day of the month for the first extraction in the file

Example: Po990802.csv contains all extraction datafor all vehicles for the month of August, 1999. The
first extraction in the file was done on 8/2/99.

ProDriver 2.x Files (.pm1)

Trip datafrom ProDriver 2.x is automatically saved in files with the extension .pom1. The.pmlfilesare
stored in the transit folder: C:\Detroit Diesel\Communicationsitransit. The files would have to be processed
with ProDriver Reports and then analyzed in that application.

DDEC I11 and Data Logger Files (.dhp)

Trip datafrom DDEC I11 and from Data L ogger is automatically saved in files with the extension .dhp.
The .dhp filesfrom DDEC 111 are stored in the Data Pages folder: C:\Detroit Diesel\Diagnostic\Data Pages.
The .dhp files from Data Logger are stored in the transit folder: C:\Detroit Diesel\Communications\transit.
Use ProManager 2.02 for data analysis and reporting on Data L ogger files.

Extraction Log Files (.elg)

.elgfilesare Extraction Log Files. At the beginning of each month, Communications Manager
automatically removes the extraction log data for the month before the one that has just finished and
archivesit in aseparate extraction log file. Use the Extraction Log Viewer to open .elg files.

Setup Files (.dhe and .csf)
.dhe and .csf files are setup files created from saved selectionsin Vehicle Parameters.

Log Files (.log) - Log files are used by Detroit Diesel Technical Support.
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